User Manual

Tektronix

Tektronix
Business Network Computers
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Changes or modifications not expressly approved by Tektronix can affect emission compliance and could void the user’s authority to operate this equipment.

CANADIAN EMC REGULATORY STANDARDS

NOTICE OF COMPLIANCE

This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus set out in the Radio Interference Regulations of the Canadian Department of Communications.

CERTIFICATE OF THE MANUFACTURER/IMPORTER

We hereby certify that the Tektronix Netstations and network computers comply with the RF Interference Suppression requirements of Amtsbl.-Vfg 1046/1984. The German Postal Service was notified that the equipment is being marketed. The German Postal Service has the right to re-test the series and to verify that it complies.

BESCHEINIGUNG DES HERSTELLERS/IMPORTEURS


NOTICE to the user/operator:

The German Postal Service requires that Systems assembled by the operator/user of this instrument must also comply with Postal Regulation, Vfg. 1046/1984, Par. 2, Sect. 1.

HINWEIS für den Benutzer/Betreiber:

Die vom Betreiber zusammengestellte Anlage, innerhalb derer dies Gerät eingesetzt wird, muss ebenfalls den Voraussetzungen nach Par. 2, Ziff. 1 der Vfg. 1046/1984 genügen.


Printed in the United States of America or the United Kingdom. All rights reserved. This document may not be copied in whole or in part, or otherwise reproduced except as specifically permitted under U.S. copyright law, without the prior written consent of Tektronix, Inc., P.O. Box 1000, Wilsonville, Oregon 97070-1000.

TEKTRONIX, TEK, and UTek are registered trademarks of Tektronix, Inc. Ethernet is a trademark of Xerox Corporation; UNIX is a registered trademark of AT&T; DEC, ULTRIX, VMS, and VT are trademarks of Digital Equipment Corporation; X and X Window System are trademarks of the Massachusetts Institute of Technology. Microsoft and Windows NT are registered trademarks of Microsoft Corporation. Other trade names used in this document are trademarks or registered trademarks of the manufacturers or vendors of the associated products.

Portions of the network computer source code are copyrighted © 1989 by Sun Microsystems, Inc. Sun design patents pending in the U.S. and foreign countries. OPEN LOOK is a trademark of AT&T. Used by written permission of the owners.

Portions of this NCBridge software © 1984-94 Adobe Systems Incorporated. All rights reserved.

Some fonts are copyrighted © 1986 by Bigelow & Holmes. Lucida is a registered trademark of Bigelow & Holmes. Adobe, Acrobat, Display PostScript, and ShowPS are trademarks of Adobe Systems Incorporated which may be registered in certain jurisdictions.
## Manual Revision Status

### Tektronix Business Network Computer User Manual

<table>
<thead>
<tr>
<th>Rev Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>July 1997</td>
<td>Original Issue.</td>
</tr>
</tbody>
</table>
# Contents

<table>
<thead>
<tr>
<th>Chapter 1</th>
<th>A New Piece of Hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is a Business Network Computer?</td>
<td>1-1</td>
</tr>
<tr>
<td>Why Use a Network Computer</td>
<td>1-3</td>
</tr>
<tr>
<td>How Do You Use a Network Computer</td>
<td>1-4</td>
</tr>
<tr>
<td>Terminology</td>
<td>1-5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 2</th>
<th>Operating the Network Computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Powering on the Network Computer</td>
<td>2-1</td>
</tr>
<tr>
<td>The Network Computer Boot Process</td>
<td>2-2</td>
</tr>
<tr>
<td>Logging in to the Network Computer</td>
<td>2-3</td>
</tr>
<tr>
<td>Logging in from the Root Weave</td>
<td>2-4</td>
</tr>
<tr>
<td>Logging in with Client Launcher</td>
<td>2-5</td>
</tr>
<tr>
<td>Logging in with HostMenu</td>
<td>2-6</td>
</tr>
<tr>
<td>Logging in at a Login Prompt</td>
<td>2-9</td>
</tr>
<tr>
<td>Logging in with Telnet</td>
<td>2-11</td>
</tr>
<tr>
<td>Closing a Telnet Window</td>
<td>2-12</td>
</tr>
<tr>
<td>Logging in with Cterm</td>
<td>2-13</td>
</tr>
<tr>
<td>Closing a Cterm Window</td>
<td>2-14</td>
</tr>
<tr>
<td>Logging in with WinDD</td>
<td>2-15</td>
</tr>
<tr>
<td>Closing a WinDD Session</td>
<td>2-18</td>
</tr>
<tr>
<td>Logging in with Serial Port 0 or 1</td>
<td>2-19</td>
</tr>
<tr>
<td>Closing a Serial Port Window</td>
<td>2-19</td>
</tr>
<tr>
<td>Logging in with LAT</td>
<td>2-22</td>
</tr>
<tr>
<td>Closing a LAT Window</td>
<td>2-23</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 3</th>
<th>Using the Network Computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>X Window Software Components</td>
<td>3-1</td>
</tr>
<tr>
<td>Getting Unstuck</td>
<td>3-4</td>
</tr>
<tr>
<td>Window Managers</td>
<td>3-5</td>
</tr>
<tr>
<td>Determining if a Window Manager is Running</td>
<td>3-5</td>
</tr>
<tr>
<td>Starting a Window Manager</td>
<td>3-6</td>
</tr>
<tr>
<td>Using a Window Manager</td>
<td>3-6</td>
</tr>
<tr>
<td>Starting Sessions</td>
<td>3-12</td>
</tr>
<tr>
<td>Running Clients</td>
<td>3-13</td>
</tr>
<tr>
<td>Locking the Display</td>
<td>3-14</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 4</th>
<th>Using Advanced Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Player</td>
<td>4-2</td>
</tr>
<tr>
<td>Starting the Audio Player</td>
<td>4-4</td>
</tr>
<tr>
<td>Opening or Creating an Audio File</td>
<td>4-6</td>
</tr>
</tbody>
</table>
Contents

Using TFTP Access................................. 4-7
Using NFS Access................................. 4-9
Using DAP Access ................................. 4-12
Connecting External Audio Devices ......... 4-15
Audio Accessory Specifications ............... 4-16
Recording an Audio File ....................... 4-17
Playing an Audio File ............................ 4-19
Audio File Information ......................... 4-20
Closing the Audio Player ...................... 4-20
The Audio Mixer .................................... 4-21
Starting the Audio Mixer ...................... 4-22
Using the Audio Mixer ........................... 4-22
Saving the Audio Mixer Level Settings ..... 4-23
Closing the Audio Mixer ....................... 4-23
Digital Video Player ............................. 4-24
Starting the Video Player ...................... 4-25
Opening a Video File ......................... 4-28
Using TFTP Access ............................. 4-29
Using NFS Access ............................... 4-31
Using DAP Access ............................... 4-32
Playing a Video File ......................... 4-34
Fast Forwarding and Rewinding ............ 4-35
Multicast ........................................... 4-36
Closing the Video Player ...................... 4-39
Analog Video Player .............................. 4-40
Starting the Analog Video Player ........... 4-42
Connecting The Network Computer to an Analog Video Device ... 4-43
Using the Analog Video Player .............. 4-44
Closing the Analog Video Player ............ 4-47
The XIE Viewer .................................... 4-48
Starting the XIE Viewer ...................... 4-49
Opening and Displaying an Image File .... 4-51
Using TFTP Access ............................. 4-52
Using NFS Access ............................... 4-53
Using DAP Access ............................... 4-55
Viewing Options .................................. 4-58
Closing the XIE Viewer ....................... 4-58
WinDD ............................................... 4-59
Starting Local WinDD ......................... 4-59
Configuring your WinDD Session from the Client Screen ........... 4-63
PSXpress ........................................... 4-67
Changing Execution Paths .................... 4-67
Integrating Icons into an OpenWindows Desktop ................. 4-67
Using Display PostScript NX with Sun AnswerBook .......... 4-68
Contents

X Resources and Application Defaults.............................................4-68
PostScript Resources .................................................................4-68
Launching Applications ...............................................................4-69
Locating Acrobat Reader Preferences File ...................................4-70
Printing Documents with Acrobat Reader .................................4-72
Converting PDF Files to PostScript Files with Acrobat Reader ....4-72
Using Display PostScript NX with Other Applications ...............4-73
Location of Documentation ..........................................................4-73
Font Caching .................................................................................4-74
Printing Color Hardcopies .............................................................4-75
  Printing from MWM ...............................................................4-75
  Printing from the Command Line ..........................................4-76
Flash Control Console .................................................................4-77
Before Using the FCC ................................................................4-78
Starting the FCC .........................................................................4-78
  The File Bar ...........................................................................4-79
  The Menu Bar ......................................................................4-80
  The Menu Input Area ..........................................................4-80
  The Message Box ..................................................................4-82
The Flash Screen ..........................................................................4-83
  After Doing an Analysis .......................................................4-84

Chapter 5 Troubleshooting
Solving Power Problems ............................................................5-1
Solving Boot Problems ..............................................................5-2
Solving Log in Problems .............................................................5-3
The Console Window ..................................................................5-4
  Opening the Console Window .............................................5-4
  Using the Console Window ................................................5-5
  Closing the Console Window ..............................................5-6

Appendix A Special Keyboard Characters
Keyboard Charts ........................................................................A-2
Entering North American Special Characters from International KeyboardsA-9
Compose and Diacritical Sequences ........................................A-21
  Using the Diacritical Keys ..................................................A-23
  Using the Compose Key .....................................................A-26
Contents
Preface

Typographical Conventions

This manual uses the following typographical conventions:

- This symbol indicates additional or background information for the particular section. For example, the symbol is used in Chapter 2 to refer to the specific commands that were set by your system administrator.

- This symbol indicates a Launcher Menu selection. Depending on how your account is set up, the Launcher may already be on your screen. If that is the case, simply use the mouse to select an option. If the Launcher is not present, press the Setup key or key sequence for your keyboard.

Table 1 Setup Key and Key Sequences.

<table>
<thead>
<tr>
<th>Keyboard Type</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>101/102 with Setup</td>
<td>Setup key</td>
</tr>
<tr>
<td>101/102 with Pause</td>
<td>SHIFT-Pause</td>
</tr>
<tr>
<td>Sun keyboard</td>
<td>ALT-GRAPH-HELP</td>
</tr>
<tr>
<td>3270 keyboard</td>
<td>Right ALT-ExSel (The left ALT key does not work)</td>
</tr>
<tr>
<td>LK401</td>
<td>F3 key</td>
</tr>
<tr>
<td>UNIX keyboard</td>
<td>Alt-Graph</td>
</tr>
</tbody>
</table>

Figure 1 illustrates the typographical conventions used in this manual.

The following terminology is used to describe mouse operations.

*Pointing*: use the mouse to position the pointer on an object on the display

*Moving*: use the mouse to change the location of the pointer on the display

*Clicking*: press and release a mouse button without moving the pointer

*Dragging*: press and hold down a mouse button while moving the pointer

*Releasing*: release the mouse button to complete a dragging action
Enabling BOOTP

Bootstrap protocol, bootp, is the recommended way to establish connectivity to the Network Computer in an IP environment. bootp obtains:

1. Verify that the bootpd and bootptab files are in the /etc directory.

2. If they are not there:
   ```
   # cp /tekxp/bin/<host>/bootpd /etc
   ```

3. Edit the /etc/hosts file to add the Network Computer internet address:
   ```
   128.07.60.30    portland
   ```

Entering Serial Parameters with Setup

The parameters on the host computer must match the parameters on the Network Computer in order for serial communications to work. Your system administrator should be able to tell you what parameters to enter in the remote configuration file, or tell you what parameters need to be entered in Setup.

To verify or change your serial parameters:

1. Press Setup.
2. Select Setup.
3. Drag on the Configuration Summaries menu and release on Serial Parameters.
4. Determine if your cable is connected to Serial Port 0 or 1.
5. Select the Return to Main Menu button.

Table 1. Boot Monitor Commands

<table>
<thead>
<tr>
<th>Use This Command:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authorize</td>
<td>Enable or disable auth key (authorization-key)</td>
</tr>
<tr>
<td>Required switch (choose one):</td>
<td>Specify</td>
</tr>
<tr>
<td>ROM or MOP or TFTP or NFS</td>
<td>[Read size]</td>
</tr>
</tbody>
</table>

Figure 1 Typographical Conventions.
Network Computer Package

This manual assumes you have installed your network computer according to the included pictorial instructions. Your network computer has the following components:

- The monitor is the screen where text and graphical information is displayed for viewing. You can position the monitor to a comfortable viewing angle by tilting and turning the monitor on its base. You can adjust the brightness and contrast controls according to your preference. The controls are typically located on the front or side of the monitor.

- The logic board is the controller inside your network computer that handles all input and output communications and local processing. Depending on the model of your network computer, the logic board is either located in a separate logic module (connected to your monitor with a special cable) or integrated into the base of your network computer monitor.

- The keyboard is used as the primary method for entering alphanumeric data. You can open the folding legs on the back of the keyboard to adjust the keyboard angle. There are several different keyboards available, in many different languages.

- The mouse is a device used to position a pointer appearing on the display in order to access or select information. It is used as the primary method to move about in a window manager or X window application, access menus, and select options. Information on using the mouse and the mouse buttons is in the next section of this chapter. Trackballs, touchscreens, and tablets can also be used as pointing devices. Contact your system administrator for more information on these devices.

- The communication port is a connector on the back of the cabinet housing your network computer logic board. You connect your existing network cable to this connector. A network cable must be set up for you by your system administrator. This cable must be attached to your network computer in order to run.

- The network computer software is the network computer operating system and support files that your system administrator must load and configure on a host computer so your network computer can start up. If your network computer is an optional ROM-based unit, the software may not be necessary. The software is shipped on one or more CD-ROMs or magnetic tapes. The
disks or tapes, a Network Computer Installation manual and the documentation CD-ROM with various manuals, including the Network Computer Reference manual, are shipped with the software in a separate package from the network computer.

Related Documentation

You can order this documentation from your network computer representative:

The following manuals are included in the Documentation CD-ROM, part number 063-2868-XX.

- **Network Computer Reference** — 071-0005-XX
  Provides detailed reference information about network computers.

- **Serial Xpress User** — 070-8618-XX
  Provides information about Serial Xpress for using serial connections.

- **3270/3179G User** — 070-8802-XX
  Provides operating information for the 3270/3179G terminal emulator.

The following manuals are available in paper:

- **Network Computer Installation for UNIX** — 071-0004-XX
  Network Computer Installation for VMS — 071-0009-XX
  Network Computer Installation for Windows NT — 071-0008-XX
  Explains how to install a network computer in the specified environment.

- **WinDD Administrator** — 070-9210-XX
  WinDD User — 070-9516-XX
  Provides information about the WinDD software.

- **XPT/A Graphics Tablet Operators** — 070-8050-XX
  Provides installation and operation information for the Graphics Tablet.

- **Input Extensions Reference Manual** — 061-3800-XX
  Describes how to use input extensions for the touchscreen or trackball.

The following documentation is available from Prentice Hall:

Related Documentation

Presents Motif fundamentals.
Chapter 1

A New Piece of Hardware

A box labelled network computer has been delivered to your desk. Maybe it is a replacement for your current personal computer, text-only (ASCII) terminal, or individual workstation. Or, maybe it is to be used with a new system or application. Either way, what is a network computer, and why is this new piece of hardware going to make your job any easier than the piece of hardware you used to use?

What is a Business Network Computer?

The broad definition of a network computer is an internet-capable device that supports the following features and formats:

- minimum screen resolution of 640x480
- pointing device (such as a mouse)
- text input, audio output
- TCP/IP, FTP, NFS, UDP, Telnet
- SMTP, IMAP4, POP3 (e-mail protocols)
- JPEG, GIF, WAV, AU (multimedia file formats)
- Bootp
- HTML, HTTP (web protocols)
- Java application access

This definition includes everything from internet appliances, such as set-top boxes that provide Internet access to your television, to powerful PC servers that meet these requirements. Obviously, not every device that meets these minimum requirements will be useful in a business environment.

A Tektronix Business network computer is a device-independent, network-transparent, multi-tasking device connected to a host computer in a distributed computing environment. If that makes sense, skip to Chapter 2,
Chapter 1  
A New Piece of Hardware

Operating the Network Computer. Otherwise, it really is easy to understand what a network computer is, and how it works when you consider each component used in the definition.

- **Distributed computing** allows you, from a single network computer, to take advantage of all the resources available on multiple host computers. For example, from your network computer you can access multiple hosts at one time: run a spreadsheet from one computer, create a document on a second, and receive mail from a third. A distributed-computing environment is composed of host computers joined together by a network. Figure 1-1 shows a typical distributed-computing environment.

![Figure 1-1 Typical Distributed-Computing Environment.](image)

- **Device-independent** means that your network computer can open a session on any host computer accessible to you, regardless of the computer’s operating system. With your network computer, you can even have
Why Use a Network Computer

simultaneous sessions running on totally different operating systems.

- **Network-transparent** means that your network computer can log in and run applications (called clients) on one or more host computers over the network just as if it were running locally on the computer itself. This requires a single network connection cable, not one direct cable for each host you need to access.

- **Multi-tasking** means that a client you start up in one window continues to run (in its window) even while you are using a different window. Also, a window can receive output even if it is completely hidden from view. Each window essentially functions like an individual terminal or personal computer. For you, the advantage is that you can have many different windows all on your network computer display.

**Why Use a Network Computer**

To better understand your network computer’s capabilities and advantages, consider something possibly more familiar, such as a personal computer (PC).

- The display, keyboard, and mouse serve the same function on your network computer as they do on a PC.

- Both devices require software in order to boot up and run applications. Here are some differences:
  - PC software is loaded onto a (local) disk right in the PC cabinet.
  - Network computer software is loaded onto a (remote) disk on a central computer.

The network computer advantage is that there is probably far more disk space available to the central computer than to a PC. Also, there is typically a support staff to load software and perform back ups on a central system.

- PC software is typically licensed for a single user on a single PC.

- X applications run on a network and are licensed for multiple users.

Sharing software across the network is usually more cost effective than buying and maintaining separate copies for each user.
Chapter 1  A New Piece of Hardware

- Both devices require logic boards and storage devices (disks) to handle information.

  - For a PC, the boards and disk drives are within the cabinet. You can only add a limited number of peripheral devices such as extra disks, printers, or modems.

  - For your network computer, some of the boards are inside the logic module, but your network computer takes advantage of the main computing boards, disk drives, and peripherals located on one or more remote computers.

  This is one of the key advantages of a distributed-computing environment. Computing power, storage, and access to peripheral devices like printers can be shared to maximize their use, and provide users with more flexibility. It is also far easier to share information with other users.

How Do You Use a Network Computer

1. Unpack your network computer according to the pictorial instructions on the network computer shipping box.

2. Connect the keyboard, mouse, cords, and cables as shown in the pictorial physical installation guide included in the network computer box.

3. Verify with your system administrator that the software to support your network computer has been installed on a computer. Ask your administrator if you need specific booting information.

4. Power on your network computer and log in. Chapter 2, Operating the Network Computer details these topics.

5. Run your applications. Chapter 3, Using the Network Computer describes what to do to get started.
Terminology

Like most new things, there are words and procedures that may need clarification. Before you continue, you may want to familiarize yourself with the terminology used throughout this manual. A more complete list of terms is listed in the Glossary of this book.

*Button* (on the display) A small display box within the borders of a window, or inside a dialog box. Generally, clicking on a button activates a function or performs some action.

*Button* (on the mouse) The three buttons on the top of the mouse. Table 1-1 shows the factory configuration of the buttons.

Table 1-1 Mouse Button Configuration.

<table>
<thead>
<tr>
<th>Button Name In Manual</th>
<th>3-button Mouse Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select</td>
<td>Left button</td>
</tr>
<tr>
<td>Menu</td>
<td>Middle button</td>
</tr>
<tr>
<td>Custom</td>
<td>Right button</td>
</tr>
</tbody>
</table>

*Clicking* Quickly pressing and releasing the Select mouse button without moving the pointer.

*Dialog Box* A box where you choose options and enter information. Use the mouse to move from field to field, click on buttons and position the text cursor. Enter information with the keyboard.

*Dragging* Pressing and holding the Select mouse button while moving the pointer.

*Moving* Changing the location of the pointer on the screen by moving the mouse.

*Pointer* An arrow on the screen indicating the current cursor position for selecting or clicking.

*Pointing* Positioning the pointer (such as the "x" or "↑" symbol appearing on the screen) on an object on the display by moving the mouse.
Chapter 1  A New Piece of Hardware
Chapter 2

Operating the Network Computer

Powering on the Network Computer

The first step is to power on your network computer. For network computer models with a separate logic module, power on both the display and the logic module. Figure 2-1 illustrates the location of the power switches on various models.

Figure 2-1 Power Switch Locations for Different Components.
If the network computer does not power on, refer to Chapter 5, *Solving Power Problems* for troubleshooting information.

**The Network Computer Boot Process**

When your network computer is powered on, it automatically begins booting. *Booting* means your network computer is locating and reading its start up files. The boot screen (Figure 2-2) appears on your display as the network computer is booting.

![Network Computer Boot Screen](image)

During a normal boot, the network computer successfully locates and begins to read the boot files and the *Percent of File Loaded* slide bar appears on the boot screen. During a boot, pressing any key on the keyboard halts the boot process. Do not halt the boot unless directed by your system administrator.

If the slide bar does not appear, or, if your network computer displays a *BOOT>* prompt, the boot has halted. To try the boot again, type *b* and press Enter.

If the boot fails again, call your system administrator or refer to Chapter 5, *Solving Power Problems* for more information. To help troubleshoot the boot problem, write down any messages that were displayed.
Your network computer is attempting to boot from the network or from an optional Flash memory or ROM board (read only memory). You can tell how your network computer is trying to boot by looking at the Boot Method (BMETHOD=) status line on the boot screen. Possible values are ROM, TFTP, NFS, or MOP.

Logging in to the Network Computer

The next step is dependent on how your system administrator set up the network computer software on the host computer. Each login method is illustrated and described in the following sections to help you identify your login method.

After your network computer completes the boot process, one of the following should appear on your monitor:

• Gray pattern (called the root weave) with an X cursor (page 2-4)
• Client Launcher (page 2-5)
• HostMenu (page 2-6)
• Login window prompt (page 2-9)
• Telnet window (page 2-11)
• Cterm window (page 2-13)
• WinDD (page 2-15)
• Serial Port Window (page 2-19)
• LAT Window (page 2-22)

If you cannot log in, refer to Chapter 5, Solving Power Problems for troubleshooting information.

The login method is determined by the Host Connect Method command. This command is set by the system administrator in the remote configuration file or through Setup on the network computer.
Logging in from the Root Weave

The root weave is a gray, patterned screen available on all network computers. When the network computer is ready for input, an X-shaped cursor appears on the screen. A network computer with the root weave and cursor is illustrated in Figure 2-3.

![Figure 2-3 Root Weave with X Cursor.](image)

To log in from the root weave, you need to manually start the Client Launcher. Press Setup to bring up Client Launcher. Refer to Logging in with Client Launcher on page 2-5.
Logging in with Client Launcher

Client Launcher starts the local client you select from a menu. An arrow to the right of an entry indicates a submenu. In Figure 2-4, selecting Host Connections displays a sub-menu listing available host connections, such as Telnet or Cterm.

Your system administrator configures the Client Launcher to include the local clients you use most often. The Client Launcher on your network computer may list different clients and submenus than those that appear in Figure 2-4.

Figure 2-4 Client Launcher menu.

Use one of these methods to start a client from the Client Launcher:

- Position the pointer on the client name and click the Select mouse button.
- Position the pointer on the option to display the sub-menu. Position the pointer on the client name and click the Select mouse button.

If using Client Launcher to open a host connection, see the applicable section:

- Logging in with HostMenu on page 2-6
- Logging in with Telnet on page 2-11
- Logging in with Cterm on page 2-13
- Logging in with WinDD on page 2-15
- Logging in with LAT on page 2-22

The Client Launcher appears automatically if it is specified in the remote configuration file. The applicable command is start (set to LAUNCHER).
Chapter 2  Operating the Network Computer

Logging in with HostMenu

*HostMenu* is a window showing a list of host computer names and network addresses. A sample *HostMenu* is illustrated in Figure 2-5.

Notice the list buttons across the top (for example, XDMCP and VMS TDEnet). These buttons determine which type of log in list is displayed. The button pressed in indicates which list is currently displayed.

If there are more host names than can fit on one screen, use the mouse to select the **Next Screen** and **Previous Screen** buttons to page through the host names. If your host does not appear on the list, try clicking on the **Update** button or click on one of the list choice buttons to display a different list. If it still does not appear, contact your system administrator.

![Figure 2-5 Example HostMenu.](image-url)
Logging in with HostMenu

To log in with HostMenu using either the mouse or the keyboard:

- Using the mouse, position the pointer on a host computer where you have a login account. If your host is not displayed, try the Update button or look for your host on one of the other lists (change lists by clicking one of the list buttons across the top).

- Click the Select button (left mouse button) to connect to the host.

- Using the keyboard, enter the host’s name or address in the Host text box and press Enter. If connecting to a LAT host, enter the Node’s name or address in the Node Name text box, and the Service name in the Service Name text box. Use the following keys to edit and move around the HostMenu.

<table>
<thead>
<tr>
<th>Table 2-1 Keyboard interface for HostMenu</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To:</strong></td>
</tr>
<tr>
<td>Clear the contents of a text box</td>
</tr>
<tr>
<td>Move among the text boxes</td>
</tr>
<tr>
<td>Move to the first host in the list of hosts</td>
</tr>
<tr>
<td>Move to the last host in the list of hosts</td>
</tr>
<tr>
<td>Move to a specific host in the list of hosts</td>
</tr>
<tr>
<td>Page up and down through the list of hosts</td>
</tr>
</tbody>
</table>

After selecting a log in host, some type of screen with a Login: prompt is displayed. If you selected the wrong host, press Ctrl-c to close the login box without logging in to the specified host.

- At the Login: prompt, type your user name and press Enter

- At the Password: prompt, type your user password and press Enter
Chapter 2  Operating the Network Computer

For more information, see the applicable section:

- *Logging in at a Login Prompt* on page 2-9
- *Logging in with Telnet* on page 2-11
- *Logging in with Cterm* on page 2-13
- *Logging in with WinDD* on page 2-15
- *Logging in with Serial Port 0 or 1* on page 2-19
- *Logging in with LAT* on page 2-22

Continue with Chapter 3, *Using the Network Computer*.

*HostMenu* appears automatically if it is set up as the connection method through the remote configuration file or through *Setup*. The applicable commands are: *Host Connect Method* (set to TekHostMenu) and *Default Host List* which determines the list that is initially displayed.
Logging in at a Login Prompt

If your system administrator has set up your network computer to directly log in to a specific host, some type of welcome screen with a login prompt is displayed. A welcome screen is also displayed for programs like *HostMenu* after a connection is made. Sample login screens for the UNIX host *oregon* and the VMS host IDAHO are illustrated in Figure 2-6 and Figure 2-7.

![Figure 2-6 Example UNIX Login Screen.](image)

![Figure 2-7 Example VMS Login Screen.](image)
Chapter 2 Operating the Network Computer

To log in:

- At the Login: or Username: prompt, type your user name and press Enter
- At the Password: prompt, type your user password and press Enter

Continue with Chapter 3, Using the Network Computer.

Direct connections are specified by your system administrator through the remote configuration file or through Setup. The applicable commands for UNIX systems are: Host Connect Method (XDMCP Direct), and XDMCP Server (set to your host). The applicable commands for VMS systems are: Host Connect Method (set to VMS), VMS Autologin Transport (set to TDEnet), and VMS Autologin Tdenet Host (set to your host).
Logging in with Telnet

There are two ways to log in through Telnet, depending on whether your system administrator specified a default Telnet host for your network computer. If your network computer displays a Telnet> prompt like Figure 2-8, a default host has not been specified. In this case, you must open a connection before you can log in to the host.

To open a connection to your host computer:

- Use the mouse to position the pointer in the Telnet window. You can type h and press Enter to see a list of Telnet commands.
- Type:
  
  Telnet> open hostname

  where hostname is the name or network address of the host.

Figure 2-9 Telnet Open Command.
Once a connection is made (Figure 2-10), either automatically or with the open command, you can log in:

- Type your user name at the login: prompt and press Enter
- Type your password at the password: prompt and press Enter

Figure 2-10 Telnet Window With a Host Connection.

Connected to 128.07.60.01.
Escape character is ‘^]’

login:

Telnet connection and default Telnet host are specified by the system administrator through the remote configuration file or through Setup. The applicable commands are: Host Connect Method (set to Telnet), and Default Telnet Host (set to your host name or address).

Closing a Telnet Window

Press Ctrl-D at the login: prompt to return to the Telnet> prompt without logging in to the computer.

To close the Telnet window from the Telnet> prompt, type quit and press Enter.
Logging in with Cterm

There are two ways to log in through Cterm, depending on whether your system administrator specified a default Cterm host for your network computer. If your network computer displays an NSH> or CTERM> prompt like Figure 2-11, a default host has not been specified. In this case, you must specify a connection before you can log in to the host.

To open a connection to your computer:

- Use the mouse to position the pointer in the Cterm window. You can type help and press Enter to see a list of Cterm commands.
- Type:

  CTERM> sethost hostname

  where *hostname* is the node address of the host.

Figure 2-11 Cterm Window Waiting for an Set Host Command.

Figure 2-12 Cterm Set Host Command.
Once a connection is made (Figure 2-13), either automatically or with the `sethost` command, you can log in:

- Type your user name at the *Username:* prompt and press Enter
- Type your password at the *Password:* prompt and press Enter

![Connected to host 11.10](image)

**Figure 2-13** Cterm Window With a Host Connection.

Continue with Chapter 3, *Using the Network Computer.*

Cterm connection and default Cterm host are specified by your system administrator through the remote configuration file or through *Setup.* The applicable commands are: *Host Connect Method* (set to Cterm), and *Default Cterm Host* (set to your host address).

**Closing a Cterm Window**

If you are at the *Username:* prompt and do not want to log in to the host, wait until the network connection times out and closes. A message appears on the screen when the connection closes. Typically it takes 60 seconds to time out.

To close the Cterm window from the *NSH* or *CTERM* prompt, type `quit` or `exit` and press Enter.
Logging in with WinDD

Two different WinDD screens can appear, depending on whether your system administrator specified an automatic connection to a default server. If your network computer displays the client screen illustrated in Figure 2-14, you must connect to a server before you can log in. The log in screen is illustrated in Figure 2-16.

Figure 2-14  WinDD Client Screen.

NOTE: Additional WinDD information can be found in the section titled WinDD on page 4-59 in Chapter 4, Using Advanced Features.
Selecting an Application Server

The WinDD client screen (Figure 2-14) displays a list of application servers your system administration defined for you. Use the mouse to select one of the servers from the list. If the application server you want to access is not on the list, enter the name or address in the Application Server: field and press Enter.

WinDD connection, default WinDD host, and Server entries are specified by your system administrator through the remote configuration file or through Setup. The applicable commands are: Host Connect Method (set to WinDD), Default WinDD Host (set to your default server address), WinDD Menu Entry (lists WinDD servers for HostMenu), and WinDD Host Entry (lists additional WinDD servers for the WinDD client screen).

Setting the WinDD Window Size

From the WinDD client screen, you can easily change your session attributes before you connect to a server.

The Configure button brings up the WinDD Resolution dialog box illustrated in Figure 2-15. The resolution determines the size and number of colors of the WinDD window. The resolution must be selected prior to making a connection to the application server and cannot be interactively changed until the connection has been closed. The Configure button performs the same function as the Options ⇒ Configure pulldown menu choice.
Logging in with WinDD

Logging in

Once you have made a connection, you are prompted to press Ctrl-Alt-Del to bring up the log in screen. The log in screen is illustrated in Figure 2-16. If you want to specify a different server or return to the Client screen for any reason, select Options ⇒ Log On. The Options ⇒ Log On function switches between the Client screen and the Log in screen after a server connection is made.

![WinDD Log In Screen](Image)

1. Enter your user name.
2. Use the mouse or Tab key to advance to the Password line.
3. Enter your password.
4. Press Enter or click on OK.
Chapter 2 Operating the Network Computer

Closing a WinDD Session

Close your Windows NT session as usual, by closing each of your applications, then selecting *File ⇒ Logoff* from the Program Manager.

If auto reconnect is on, the WinDD log in screen is displayed. If auto reconnect is off, the WinDD client screen appears. Select one of the following methods to close the WinDD session:

- Choose *Options ⇒ Exit*
- Click on the *Exit WinDD* button on the client screen.
- Hold Shift and Ctrl then click the middle mouse button. Select Exit WinDD from the menu.

*NOTE: Additional WinDD information can be found in the section titled WinDD on page 4-59 in Chapter 4, Using Advanced Features.*
Logging in with Serial Port 0 or 1

There are several ways to connect to a host through the Serial Port window (Figure 2-17). Check with your system administrator to find out which options you can use on your particular network computer.

- Serial communications with no protocol
- Serial communications with Serial Xpress (SXp is an option, and is not supported on all network computer models.)

You use Serial Port 0 or 1 depending on which port your serial cable is plugged into on the back of your network computer logic module.

If you have problems establishing communications, contact your system administrator.

![Figure 2-17 Serial Port Window Waiting for Command.](image.png)

Closing a Serial Port Window

To close a Serial Port window without logging in, press Enter and then type a (~) tilde followed by a (.) period.
Chapter 2 Operating the Network Computer

Entering Serial Parameters with Setup

The parameters on the host computer must match the parameters of your network computer’s serial ports in order for serial communications to work. Your system administrator can set them up for you in the remote configuration file, or tell you what parameters need to be set so you can enter them in Setup.

To verify or change your serial parameters:

1. Select Setup from the Client Launcher. If you need a refresher on the terminology used in these procedures, refer back to Chapter 1, Terminology.
2. Drag on the Configuration Summaries menu and release on Peripheral Ports.
3. Determine if your cable is connected to Serial Port 0 or 1 by checking the back of the integrated network computer or the separate logic module.
4. Verify the parameters for the port are set to the values obtained from your system administrator. Change them if necessary.
5. Select the Return to Main Menu button.
6. Select the Save Current Settings button.
7. Select the Exit Setup button.

Serial Communications with No Protocol

From the Serial Port window pictured in Figure 2-17:

• Position the mouse pointer in the Serial Port window
• If you are using a modem, type your dialing command. Typically this is something like: `atdt phone_number` Refer to your modem manual.
• Press Enter to bring up a Login: prompt
• Type your user name and press Enter to bring up the Password: prompt
• Type your password and press Enter

Continue with Chapter 3, Using the Network Computer.

Serial Port connection is specified by the system administrator through the remote configuration file or through Setup. The applicable command is: Host Connect Method (set to Serial Port 0 or 1).
Serial Communications with Serial Xpress (SXp)

A separate manual is available for Serial Xpress. Refer to the Related Documentation section in the Preface for more information.

From the Serial Port window pictured in Figure 2-17:

- Position the mouse pointer in the Serial Port window
- If you are using a modem, type your dialing command. Typically this is something like: `atdt phone_number` Refer to your modem manual.
- Press Enter to bring up a Login: prompt
- Type your user name and press Enter to bring up the Password: prompt
- Type your password and press Enter
- Start SXp on the host: type `sxprocess` and press Enter

```
Connected
Login: username
Password: xxxxx
> sxprocess
```

Figure 2-18 Starting SXp on the Host (no modem).

The Serial Port window closes and a Serial Session window is opened for you. Continue with Chapter 3, Using the Network Computer.

Serial Port connection can be specified by the system administrator through the remote configuration file or through Setup. The applicable command is: `Host Connect Method` (set to Serial Port 0 or 1).
Logging in with LAT

If your network computer displays a LAT> prompt like Figure 2-19, you are set up to log in through a Local Area Transport supported in a DECnet environment. To login, you must connect to a LAT service.

To connect to a service:

- Use the mouse to position the pointer in the LAT window. You can type help and press Enter to see a list of LAT commands.
- Type:
  LAT> services
to see a list of available services
- Type:
  LAT> connect service
  where service is the name of a valid service.
Closing a LAT Window

If it is a password protected service, enter the password at the Password: prompt. You have up to three tries to enter the password before the connection attempt fails.

Once a connection is made (Figure 2-21) you can log in:

- Type your user name at the Username: prompt and press Enter
- Type your password at the Password: prompt and press Enter

![Welcome to VAX/VMS 5.5](image)

**Username:**

**Figure 2-21 LAT Window With a Service Connection.**

Continue with Chapter 3, *Using the Network Computer.*

LAT connection can be specified by the system administrator through the remote configuration file or through Setup. The applicable command is: Host Connect Method (set to LAT).

**Closing a LAT Window**

If you are at the Username: prompt and do not want to log in to the host, wait until the network connection times out and closes. A message appears on the screen when the connection closes. Typically it takes 60 seconds to time out.

To close the LAT window from the LAT> prompt, type **quit** or **exit** and press Enter.
Chapter 2  Operating the Network Computer
Chapter 3

Using the Network Computer

What Next? might be a more appropriate title for this chapter. There really is no single answer to the What next? question. Your network computer is designed to be as flexible as possible so it can be tailored to fit your needs and your computing environment. This tailoring process is performed by your system administrator, with help from the installation and reference manuals that are included with the network computer software.

This chapter cannot tell you step-by-step how to get started, but it does provide general information to help you figure out What next?. Typically, one of the following scenarios occurs:

- A window manager starts automatically
- A client starts automatically
- Both a window manager and client start automatically
- Nothing starts (leaving you to initiate an action)

The sections in this chapter contain information on identifying what is happening on your network computer, and what choices you can make. The following topics are discussed:

- X Window Software Components
- Getting Unstuck
- Window Managers
- Sessions
- Running Clients
- Locking the Display

**X Window Software Components**

Before diving into the details of the possible scenarios, it is a good idea to understand some of the common software components and terminology.
Chapter 3  Using the Network Computer

The X Window System is a windowing system developed to enhance the usability of a host computer by utilizing an X server as a *device independent* interface between the host computer and your network computer. This means that you can run clients on computers made by different manufacturers, freeing you to focus on your applications without worrying about computer differences. Another advantage is that X is *multi-tasking*, so multiple applications can run simultaneously in different windows.

The X server is the interface that translates client requests from your network computer to the host computer. It also accepts input data from your mouse and keyboard and generates the appropriate actions.

Windows are bounded areas displayed on your network computer screen that organize the presenting of information on the screen. They can contain text (letters, numbers) or graphics (pictures, graphs, animated sequences) generated by your application programs, such as word processors, or transaction processing software. The X server controls what gets displayed inside each window. Information does not spill over from one window to the next.
A Window Manager is a special program that runs on top of the X server and provides an easy to use interface for you to run and work with your clients. These items include (among others):

- Window title bars
- Scroll bars
- Manipulating windows (sizing, moving, iconifying, closing)

Those are the visible results of using a window manager. The invisible portions may be even more important to you. These items include:

- Managing window communications to make sure the correct window receives the correct information
- Determining where your mouse pointer is positioned, so it knows where to read any input you generate

Session Windows are various types of communication protocols to establish communications between your network computer and one or more host computers.

Clients are applications designed to run on an X server in a session window. Client refers to the fact that the application is typically subordinate to the window. This means if the window is closed, the client also closes.
Getting Unstuck

Occasionally something may go wrong and your network computer or a client may get stuck or hang. *Hang* means the network computer or the client is not responding to any input coming from you or being transmitted from the host. Often times, this is due to a busy network. There are three recommended ways to try and restore communications: resetting the X Server, rebooting the network computer, or, if the keyboard is also locked up, turn off the power on the network computer.

**Resetting the X Server**

This is the first method to try.

1. Select Setup from the *Client Launcher*.
2. Click on the *Reset Server* button.
3. When prompted that this closes existing connections, click on the *OK* button.

   The screen is blanked when the reset occurs. It may take a minute or two for the server to reset. Be patient and wait. When the root weave or your login method appears, log back in as usual. Refer to Chapter 2: *Operating the Network Computer* if you need information on logging in to the computer.

**Rebooting the Network Computer**

Sometimes rebooting is necessary, even though it adds to the network load. Try Resetting the X server before you reboot.

If *Setup* does not come up, or if resetting the server did not work, try rebooting the network computer. Press the key sequence: Ctrl-Alt-Delete to try and reboot the network computer. If the reboot is successful, the boot screen is displayed while your network computer boots. Refer to Chapter 2, *The Network Computer Boot Process* for more information on booting.

**Powering off the Logic Module**

*NOTE: Turning off the power is the last-resort method. Try the other methods first, or call your system administrator for assistance.*

If neither resetting the server nor rebooting the network computer works, turn the power off then on with the power switch on your network computer logic module.
Window Managers

There are many different window managers available, but the concepts are similar. Here is a list of the more popular window managers:

- Motif (also called MWM)
- OPEN LOOK Window Manager (OLWM) (Sun hosts)
- HP VUE (for Hewlett-Packard hosts)
- DECWindows (DEC hosts)
- XpressWare Window Manager
- Tom’s Window Manager (twm)

Your system administrator sets up and configures your window manager.

Determining if a Window Manager is Running

You can tell if a window manager is running by looking at the borders on an open window. If you do not have an open window, select Setup from the Client Launcher to display the Setup window. If a window manager is running, there is a border around the window, along with a title bar and usually some command buttons. Figure 3-1 illustrates a Telnet window with and without a window manager running.

Figure 3-1 Determining if a Window Manager is Running.
Chapter 3  Using the Network Computer

Starting a Window Manager

If your system administrator configured your environment to automatically start a window manager, skip to the next section, *Using a Window Manager*.

Your system administrator must configure the window manager on your host computer before it can be used. If your network computer has either the local MWM or OLWM options, you can start it from *Client Launcher*. If the option does not appear, your network computer does not have it. Contact your system administrator.

To start local MWM, OLWM, or XP window manager from the default *Client Launcher*:

1. Open the Window Managers submenu.
2. Select *MWM* or *OLWM* or *XPWM*.

**NOTE:** If *MWM*, *OLWM*, or *XPWM* is not available, or if you use another window manager, call your system administrator. The command to start a window manager is specific to your host and configuration.

Using a Window Manager

The examples in this section are based on Motif, a host independent window manager included with your network computer software. *Host independent* means that it runs on hosts from different operating systems, rather than a proprietary manager such as HPvue that is intended for only Hewlett-Packard systems. Your windows may look and operate differently from those described here. It may be because your system administrator customized your MWM settings, or you may be using a different window manager. Refer to your window manager documentation for more information.

Figure 3-2 shows a typical window and its standard elements. A window usually has command buttons for menu access, and to minimize and maximize the window. Try the various buttons displayed with your windows.

In addition to the window menu and buttons, there are typically pop-up menus that can be accessed outside of a window. These menus are controlled by various system files. To see if you have these pop-up menus:

1. Position the pointer outside of all windows
2. Try pressing either the Select or Custom mouse buttons to see if a menu appears. Information on the menu choices would be included in your window manager or host documentation.
Figure 3-2 Elements of a Window.

These window manipulations are described in this sections:

- Moving a window
- Resizing a window
- Raising a window
- Lowering a window
- Maximizing a window
- Iconifying a window
- Restoring an icon
- Moving an icon
Chapter 3 Using the Network Computer

Moving a Window

Windows can be moved from one location to another on the display.

1. Position the pointer within the title bar or border of the window.

2. Drag the pointer. When you begin moving the window, the pointer changes to a cross-arrow pointer and a window outline appears. As you move the pointer, the outline tracks the movement. A small rectangle appears in the center of the screen and displays the x and y coordinates of the window as the window moves.

3. Once the window is in the desired location, release the mouse button. The window appears in the new location and becomes the active window.

Alternate method: Drag on the Window Menu, release on Move, position the window outline (by moving the mouse), and click a mouse button.

Resizing a Window

Many windows can be resized. The corners of the window border let you resize the window in two directions, while the horizontal borders and vertical borders let you resize the window in a single direction.
Using a Window Manager

1. Position the pointer on the window border or resize corner controlling the window side(s) you want to resize. The pointer changes to either an arrow with a corner (for resizing two sides) or to an arrow with a perpendicular bar (for resizing in one direction).

2. Drag the corner or window border in the direction desired. As you resize the window, an image of the moving border(s) tracks the pointer movement.

3. Release the mouse button. The window appears in the new size.
   Alternate method: Drag on the Window Menu, release on Size, position the window outline (by moving the mouse), and click a mouse button.

Raising a Window

A window may need to be raised to be in front of any overlapping windows so you can see the entire window.

1. Position the pointer anywhere in the window to raise (except on any of the command buttons).

2. Click the Select mouse button. Raising a window automatically makes that window active. Windows cannot be raised from the Window Menu.

   NOTE: There is an X feature called autoraise. If this feature is configured for your window manager, windows are automatically raised as soon as you position your mouse pointer in the window.
Chapter 3 Using the Network Computer

Lowering a Window

You can place a window behind overlapping windows.

1. Drag on the Window Menu in the window to lower.
2. Release on Lower.

Maximizing a Window

A window can be maximized to take up the entire size of the display. Some clients do not support maximized windows.

1. Click on the Maximize button in the window you want to maximize.
2. To return the window to its original size, click the Maximize button again. Alternate method: Drag on the Window Menu and release on Maximize.
Iconifying a Window

A window can be iconified. This helps keep your windows organized and easy to access.

Click on the Minimize button in the window you want to iconify.

MWM has a client called Icons. If this client is available, it provides a box to hold and sort all of your icons.

Alternate method: Drag the Window Menu and release on Minimize.

Restoring an Icon

You can restore an icon back into a window if you want to see the window contents, or is you want to work in the window.

Double-click the Select button on the icon you want to restore.

Alternate method: Click the icon once to display a pull-down menu, and then click on Restore.
Chapter 3 Using the Network Computer

Moving an Icon

You can move an icon from one location on the display to another.

1. Drag the pointer on the icon you want to move. When you begin moving the icon, the pointer changes to a cross-arrow and an icon outline appears.

   As you move the pointer, the outline tracks the movement.

2. Once the icon is in the desired location, release the mouse button. The icon appears in the new location.

Alternate method: Click the icon once to display a pull-down menu, click on Move, position the icon outline (by moving the mouse), and click a mouse button.

Starting Sessions

As you learned when you read Logging in to the Network Computer in Chapter 2, there are many different ways to establish communications with one or more host computers. With a network computer you can have multiple sessions open and running simultaneously. For example, you might open a word processor, cut some text out of file, and paste it into window where you are composing some electronic mail. Or, you might open a session into another host to check if a customer order has been shipped. All without having to exit your application.

Before you start a session, you typically need to know the name, or address of the remote host. You can find this out by calling your system administrator.

There are different types of addresses based on the network protocol used at your site. Internet protocol (IP) addresses (128.06.70.01 for example) are used for networks running a protocol called TCP/IP. This is the most common
Running Clients

network for hosts running a UNIX operating system. Node numbers (11.10:: for example) are used for networks running a protocol called DECnet. This is the most common network for hosts running a VMS operating system.

There are two easy ways to start a new session from Client Launcher. If you need a refresher on the terminology used in these procedures, refer back to Chapter 1, Terminology. Use one of these methods:

1. Select TekHostMenu. When the HostMenu client appears, use the mouse to select your host. Refer to Logging in with HostMenu on page 2-6 for details.

   NOTE: If you logged in with XDMCP, the XDMCP list is not available on HostMenu. Only one XDMCP session can be running.

2. Select a session from the Host Connections submenu:
   - Telnet (refer to Logging in with Telnet on page 2-11)
   - Console (refer to The Console Window on page 5-4)
   - Cterm (refer to Logging in with Cterm on page 2-13)
   - WinDD (refer to Logging in with WinDD on page 2-15)
   - Serial Port 0 or 1 (refer to Logging in with Serial Port 0 or 1 on page 2-19)
   - LAT (refer to Logging in with LAT on page 2-22)

   NOTE: Grayed text indicates an option that is not enabled for your particular network computer. If an option is not listed, it is not available for your network computer model.

Running Clients

Clients refer to applications that run on your network computer, such as a desktop publishing system, a computer-aided design program, or an on-line transaction processing system. Your network computer can run multiple clients simultaneously.

Your system administrator can set up your login files to automatically start one or more clients each time you login. The other alternative is for you to start the clients you need.

Typically you start clients either of two ways:

- From a session window, type the command to start your particular client and press Enter. Instructions for starting clients are included with your application documentation.
Chapter 3 Using the Network Computer

- If your host computer or window manager has command menus available, there may be menu choices available to automatically start your applications:
  
  - Position the pointer outside of a window.

  - For MWM, you would press the Select mouse button and click on your client. For other window managers, follow the instructions for menu and item selection and select the client you want to run.

  Refer to the documentation that came with your application for application-specific operation and information.

Locking the Display

You can lock your display and all open windows so that while away from your desk, an unauthorized user cannot access the information on your display. The xlock local client locks the keyboard only, or the keyboard and the display.

1. xlock can be started from the Client Launcher (select Lock Screen) or with xpsh from the command prompt:

   \[ \text{xpsh -display nc_address:0 xlock -mode n} \]

   To determine the network computer address, select Setup from the Client Launcher. Drag on Configuration Summaries and release on TCP/IP (for a UNIX host) or TDEnet (for a VMS host). The address displays as the network computer IP Address or the TDEnet Address.

   The \text{-mode n} setting is optional. If set to \text{-mode 1}, xlock locks the keyboard only. If set to \text{-mode 0}, xlock locks the keyboard and the screen. If a \text{-mode} setting is not given, xlock locks the keyboard and the screen by default. If you receive a Command not found message, have your system administrator add \text{xpsh} to your path environment variable and try the \text{xpsh} command again.

   When xlock is started, the xlock window appears (Figure 3-3).
2. At the Password prompt, enter a password and press Enter.

3. At the Retype prompt, enter the password again and press Enter. This verifies you have entered the password correctly. Xlock remains in effect until you re-enter the password. The password is valid until you reboot the network computer or reset the server.

4. To unlock the display or keyboard, press any key for the xlock window. At the Password prompt, enter the password.

   NOTE: If you forget your password, you must reboot the network computer or reset the server to unlock the display or keyboard.
Chapter 3 Using the Network Computer
Using Advanced Features

This chapter provides information about the advanced NCBridge software features:

- *Audio Player* for recording and playing audio files on the network computer
- *Audio Mixer* for controlling the audio volume for the line in and microphone on the network computer
- *Digital Video Player* for playing NTSC or PAL video sources on the network computer
- *Analog Video Player* for playing analog video sources on the network computer
- *XIE Viewer* for viewing image files on the network computer
- *WinDD* to run Windows NT applications on a PC server
- *PSXpress* for using the Display PostScript NX and Acrobat software
- *Font Caching* for storing fonts in your network computer’s memory
- *Printing Color Hardcopies* from your network computer
- *Flash Control Console* for flashing multiple network computers from a single location.
Audio Player

The Audio Player plays and records digital audio files. When started, the Audio Player displays as shown in Figure 4-1.

The player can play files with the following extensions:

- .au — Sun file type header
- .wav — Microsoft file type header
- .voc — Sound Blaster file type header (Play only)
- .aiff — Macintosh file type header
- .snd — Macintosh file type header
Audio Player

- .raw — no file header

If a file does not have an extension, the player attempts to read its header information. If there is no header information, the player plays it as a headerless file (.raw).

The Audio Player supports the file formats 8-bit linear, 8-bit uLaw, 8-bit aLaw, and 16-bit linear (LSB & MSB).

The following information about using the Audio Player is available:

- **Starting the Audio Player** provides information about the various ways to start the Audio Player
- **Opening or Creating an Audio File** provides information about opening and creating audio files
- **Connecting External Audio Devices** provides information about the types of external devices that can be used with recording audio files
- **Recording an Audio File** provides the steps for recording an audio file
- **Playing an Audio File** provides the steps for playing an existing audio file
- **Audio File Information** provides information about obtaining original audio file recording information
Starting the Audio Player

The Audio Player can be started from the Client Launcher, from the remote configuration file, or with `xpsh`.

>>> CAUTION Before connecting any audio device to the network computer (such as microphones or headsets), close all clients, remote connections, and power down the network computer. Connecting devices to the network computer’s audio connectors with power applied could result in a loss of data. After the devices are connected, start the Audio Player.

Starting the Audio Player from the Client Launcher

From the Multimedia submenu, select Audio Player. The Audio Player displays as shown in Figure 4-1.

Starting the Audio Player from the Remote Configuration File

The `start AUDIO_PLAYER` command in the remote configuration file (`xp.cnf`) automatically downloads and starts the Audio Player when the network computer boots. Refer to the `start` command in Chapter 2 of the TekXPress Reference manual for details.

Starting the Audio Player with `xpsh`

`xpsh` can start the Audio Player client as shown in Figure 4-1, or can simply play an audio file without opening the Audio Player. To start the Audio Player with `xpsh`, enter the following:

```
xpsh -display nc_name:0 aplay
```

The following options can be set on the `xpsh` command line:

- `-h host` — specifies the host name or address on which the audio file resides. The host must be entered in the network computer’s Internet Host Table in Setup. This host displays in the Audio Player’s File Information area.

- `-f filename and path` — specifies the audio file name and its entire path. This file displays in the Audio Player’s File Information area.

- `-a access method` — specifies the access method used to access the audio file. Available access methods are `tftp`, `nfs`, and `dap`. 
**Starting the Audio Player**

- **v volume level** — specifies the volume level to use when playing the audio file. Specify a number between 0 and 100, with 0 indicating no volume, and 100 indicating the loudest volume setting.

- **p** — when used with the -h, -f, -a, and -v options, the specified file plays without opening the Audio Player. The entire file plays and cannot be interrupted.

**Examples**

This example starts the Audio Player on the network computer named *sierra*:

```
xpsh -display sierra:0 aplay
```

This example starts the Audio Player with the host *portland* and the audio file `/usr/adam/story.au` preloaded in the Audio Player’s File Information Area:

```
xpsh -display sierra:0 aplay -h portland -f /usr/adam/story.au
```

This example plays the audio file `/usr/adam/story.au` (located on the host *portland*) on the network computer without opening the Audio Player:

```
xpsh -display sierra:0 aplay -h portland -f /usr/adam/story.au -a tftp -p
```
Opening or Creating an Audio File

The *Open* command on the File menu creates a new file to record, or opens an existing file.

1. Select the *Open* command from the File menu. The File Selection window appears. See Figure 4-2.

2. To select the access method to use, position the mouse pointer on the NFS button and click. A drop down menu displays the available methods: TFTP, NFS, or DAP. The File Selection window changes to reflect the chosen access method.

![Figure 4-2 File Selection.](image)
Using TFTP Access

The following File Selection window displays when tftp is the access method.

![Figure 4-3 TFTP File Selection Window.](image)

**NOTE:** Use tftp as the access method only if NFS is not available. NFS provides better and more accurate data transfer rates required to maintain continuous audio stream.

*If using tftp as the access method, the Audio Player cannot play a file that is greater than 16MB. If you attempt to play a file larger than 16MB, the player will ignore the file.*
Creating a New Audio File Using TFTP Access

When creating a new audio file using tftp as the file access, the file must exist and have world write permissions before the audio data can be written to it. In addition, only the .au, .wav, and .raw file extensions can be used with tftp.

1. Create the new audio file and give it world read and write permissions.

2. Enter the Host name or address on which the file will be stored in the Host field.

3. Enter the filename, path, and extension in the Path field. Use only the .au (Sun file type) or .raw (no header) file extensions.

4. Click on OK to open the file. The host and file names display in the File Information Area.

Opening an Existing Audio File Using TFTP Access

1. Enter the name or address of the host on which the file is located in the Host field.

2. Enter the file’s path, filename, and extension in the Path field. Files with the following extensions can be played on the Audio Player:
   - .au — Sun file type
   - .wav — Microsoft file type
   - .voc — Sound Blaster file type
   - .aiff — Macintosh file type
   - .snd — Macintosh file type
   - .raw — no file header
   
   If an extension is not given, the player attempts to read the file’s header information. If the file does not have a header, the player plays it as a headerless file (.raw).

3. Click OK. The host and file names display in the File Information Area.

When opening an existing file, you can choose the Info command to see the file’s original recording information. Refer to the Info command later in this chapter for more information.
Using NFS Access

The following File Selection window displays when NFS is the access method.

![NFS File Selection Window](image)

Figure 4-4 NFS File Selection Window.
Creating a New Audio File Using NFS Access

When using NFS as the file access, an NFS mount must be established to the host on which the file resides and must have world read and write access.

1. Enter the local NFS mount point to the network computer in the Filter field.

2. Enter the full path, filename, and extension in the Selection field. The following file extensions are available:
   - .au — Sun file type
   - .wav — Microsoft file type
   - .aiff — Macintosh file type
   - .snd — Macintosh file type
   - .raw — no file header

   If an extension is not given, the file is recorded as a headerless file (.raw).

3. Click OK. The host and file names display in the File Information Area.

Opening an Existing Audio File Using NFS Access

1. Enter the NFS mount point in the Filter field.

2. Click on the Apply Filter button. All subdirectories and files are listed in the Directories and Files areas.

3. To view files in a different directory, click on the directory name in the Directories area, and then click on the Apply Filter button. The files in that directory are listed in the Files area.
4. Select the file you want in the Files area. The full path and filename prefills in the Selection field. Enter one of the following file extensions:

- .au — Sun file type
- .wav — Microsoft file type
- .voc — Sound Blaster file type
- .aiff — Macintosh file type
- .snd — Macintosh file type
- .raw — no file header

If an extension is not given, the player attempts to read the file’s header information. If the file does not have a header, the player plays it as a headerless file (.raw).

5. Click OK. The host and file names display in the File Information Area.

When opening an existing file, you can choose the Info command to see the file’s original recording information. Refer to the Info command later in this chapter for more information.
Chapter 4  Using Advanced Features

Using DAP Access

The following File Selection window displays when DAP is the access method.

![Figure 4-5 DAP File Selection Window.](image)

Figure 4-5  DAP File Selection Window.
Creating a New Audio File Using DAP Access

1. Enter the node name or address in the Node field. This is the node on which the file will be stored.

2. Enter the full path, filename, and extension in the Selection field. The following file extensions are available:
   - .au — Sun file type
   - .wav — Microsoft file type
   - .aiff — Macintosh file type
   - .snd — Macintosh file type
   - .raw — no file header
   
   If an extension is not given, the file is recorded as a headerless file (.raw).

3. Click OK. The host and file names display in the File Information Area.

Opening an Existing Audio File Using DAP Access

1. Enter the node name or address in the Node field. This is the node on which the file is located.

2. Enter the file’s path and directory in the Filter field.

3. Click on the Apply Filter button. All subdirectories and files are listed in the Directories and Files areas.

4. To view files in a different directory, click on the directory name in the Directories area, and then click on the Apply Filter button. The files in that directory are listed in the Files area.
Chapter 4 Using Advanced Features

5. Select the file you want in the Files area. The full path and filename prefills in the Selection field. Enter one of the following file extensions:

- .au — Sun file type
- .wav — Microsoft file type
- .voc — Sound Blaster file type
- .aiff — Macintosh file type
- .snd — Macintosh file type
- .raw — no file header

If an extension is not given, the player attempts to read the file’s header information. If the file does not have a header, the player plays it as a headerless file (.raw).

6. Click OK. The host and file names display in the File Information Area.

When opening an existing file, you can choose the Info command to see the file’s original recording information. Refer to the Info command later in this chapter for more information.
Connecting External Audio Devices

Figure 4-6 shows the audio input and output connectors on the rear of the logic module. All of the jacks accept a 3.5 mm stereo phone plug.

>>> CAUTION Before connecting any audio device to the network computer, close all clients, remote connections, and power down the network computer. Connecting devices to the network computer’s audio connectors with power applied could result in a loss of data.

- If you are using a microphone for audio input, plug it into the Mic input jack.

- A line level signal from a stereo audio source such as an audio mixer, pre-amplifier, compact disc player, or tape player, plugs into the line-in jack, which is marked with the symbol.

- The line-out jack is marked with the symbol and provides a line-level stereo signal for use by a mixer, pre-amplifier, tape player, or other equipment that can accept a line level input. This output provides the highest quality audio.

- The headphone jack is for use with stereo headphones, 8Ω stereo speakers (unpowered), and powered speaker sets that connect to personal listening players (e.g. Discman®). Plugging in to this jack disables the internal monitor speaker.

![Figure 4-6 Input and Output Jacks](image)
Chapter 4 Using Advanced Features

Audio Accessory Specifications

The following specifications can assist you when choosing accessories to use with the Audio board.

**Microphone Specifications**
- **Microphone Type**: Dynamic
- **Impedance**: Medium to High (600 to 1000 Ω at 1 kHz)
- **Sensitivity**: -55 to -70 db (at 1 kHz)
- **Frequency Range**: 50 Hz to 16 kHz
- **Cord Length**: 6 feet or longer
- **Plug**: 3.5 mm monaural phone plug

**Line Input Specifications**
- **Signal Level**: 0.775 Vrms nominal
- **Input Impedance**: High (greater than 20 KΩ)
- **Plug**: 3.5 mm stereo phone plug

**Line Output Specifications**
- **Signal Level**: 0.775 Vrms into a 600 Ω load
- **Plug**: 3.5 mm stereo phone plug

**Speaker/Headphone Specifications**
- **Impedance**: 8 Ω (min)
- **Plug**: 3.5 mm stereo phone plug
Recording an Audio File

The Audio Player works much like a home stereo. It has a record button, a stop button, and a play button. It also has a number of recording settings you can adjust so that the audio file is recorded for the type of device on which it will be played. Audio files can be played on almost any computer that has audio capabilities, including network computers, Personal Computers, and workstations.

When a new file is created, the default file settings reflect the device on which it will be recorded, in this case, the network computer.

If an existing file is opened, the settings displayed in the Audio Player reflect the settings at which the file was recorded if the network computer can support the settings. If not, the Audio Player adjusts the settings to best match the network computer’s capabilities. To see the exact settings at which the audio file was recorded, select the Info command from the File menu.

Before recording, attach any external audio devices. Refer to the previous section, Connecting External Audio Devices.

Before recording, set the following recording options:

- **Frequency**: Select a sampling frequency. The higher the frequency, the clearer the recording. The available frequency settings are limited to the network computer hardware. You cannot record at a frequency higher than the network computer supports. If you try to record at an unsupported frequency, a warning displays.

- **File Format**: Select a file format. The File Format determines how the audio file is stored.

- **Input Source**: Select the input source of the audio data: microphone, stereo line, video line, or a mix of multiple sources. Refer to the Audio Mixer for information about mixing input sources. Refer to the Audio Mixer section later in this chapter for details about the Audio Mixer.

- **Stereo**: This option toggles the stereo option. Select this option to record in Stereo, or un-select it to record in mono.

- **Mic Boost**: This option toggles the Microphone boost option. Select this option to increase the sensitivity of the microphone.
Chapter 4  Using Advanced Features

Recording Levels  Sets and shows the recording level. Slide the recording level indicator to the right to increase the levels. The Left and Right feedback area shows the decibel levels during recording. If the levels reach the "red area", indicated by red bars, the recording may be at too high a level. Slide the recording indicator to the left to reduce the recording level.

Recording Length  Sets a maximum recording time limit (up to 999999 seconds). Use this option if you want to control the length of the recording. When the recording reaches the time limit, the player automatically stops recording.

After setting the recording options, you are ready to record:

1. Use the Open command to open an existing file, or to create a new file.

2. Click on the Record button. The recorder starts and continues to record until you click on the Stop button.

3. To stop recording, click on the Stop button.

4. To rewind to the audio file, click on the Rewind button. The file rewinds to the beginning.

5. To play the audio file, click on the Play button.

6. To adjust the volume, slide the volume controller to the right to increase the volume, or to the left to decrease the volume. Be sure the Sound button is on, or pushed in. The Sound button acts as a mute toggle; when it is pushed in, you can hear the sound, when it is off, the sound is muted.

To make recording adjustments, change any of the recording options and go back to Step 2. Repeat this procedure as needed.

NOTE: If using TFTP as the file access method, some versions of TFTP overwrite the file’s contents after the file is recorded when the file’s header information is added. If this occurs, use NFS as the file access method.
Playing an Audio File

Files with the following extensions can be played with the Audio Player:

- .au — Sun file type
- .wav — Microsoft file type
- .voc — Sound Blaster file type
- .aiff — Macintosh file type
- .snd — Macintosh file type
- .raw — no file header

If a file does not have an extension, it is played as a .raw file.

To play an audio file:

1. Use the Open command on the File menu to open the audio file. When the file is opened, use the Info command on the File menu to view the recording settings. These settings may differ from the settings displayed on the Audio Player. The Audio Player settings reflect the current hardware capabilities. The original recording settings may not be available on the hardware, so the Audio Player automatically adjusts the settings to best match those that are available with the hardware.

2. Click on the Play button.

3. To adjust the volume, slide the volume controller to the right to increase the volume, or to the left to decrease the volume. Be sure the Sound button is on, or pushed in. The Sound button acts as a mute toggle; when it is pushed in, you can hear the sound, when it is off, the sound is muted.

4. To stop playing the file, click on the Stop button. To restart the file from where it stopped, click on the Play button.

5. To rewind the audio file to the beginning, click on the Rewind button.
Audio File Information

After opening a file that already exists, use the *Info* command on the File menu to display a window with the file’s original recording information. The filename, frequency, format, channel, and duration information displays as shown in Figure 4-7.

![Figure 4-7 File Information Window.]

When opening an existing file, the options displayed on the Audio Player reflect the current hardware capabilities. The original recording settings may not be available on the hardware, so the Audio Player automatically adjusts the settings to best match those that are available with the hardware.

To close the File Information window, click the CANCEL button.

Closing the Audio Player

To close the Audio Player, select the *Quit* command from the File menu. Any open file information is saved and the player exits.
The Audio Mixer

The Audio Mixer allows you to control the hardware volume for line in, microphone, and pre-recorded (digital) sources. You are not required to use the Audio Mixer when recording or playing audio or video files. When started, the Audio Mixer displays as shown below:

![Figure 4-8 Audio Mixer.](image)

The Audio Mixer is like a master volume control, much like the volume control on a home stereo receiver. The volume control on the stereo receiver controls the output volume for all the stereo components, such as the tape player and the CD player. Likewise, the mixer controls the input and output gain for the Line In, Digital, and Microphone sources.

Each volume control has a toggle Sound button. When clicked on, the sound is heard. When off, the sound is muted until it is selected again. This allows you to quickly mute the sound and then to resume.
Chapter 4   Using Advanced Features

Starting the Audio Mixer

The Audio Mixer can be started from the Client Launcher, from the remote configuration file, or with xpsh.

Starting the Audio Mixer from the Client Launcher

From the Multimedia submenu, select Audio Mixer. The Audio Mixer displays as shown in Figure 4-8.

Starting the Audio Mixer from the Remote Configuration File

The start AUDIO_MIXER command in the remote configuration file (xp.cnf) can be used to automatically download and start the Audio Mixer when the network computer boots. Refer to the start command in Chapter 2 of the Tektronix NC200/NC400 Network Computer Reference manual for details.

Starting the Audio Mixer with xpsh

xpsh can open the Audio Mixer client, as shown Figure 4-8. To open the Audio Mixer with xpsh, enter the following:

xpsh -display nc_name:0 mixer

Using the Audio Mixer

To use the Audio Mixer to monitor input, adjust the volume levels of the Line In Gain, Digital Gain, and the Microphone Gain, depending on what you are using as the input source(s).

• When playing an audio file, the Audio Mixer sets the output levels for each of the input sources relative to each other.

• When recording an audio file, the Audio Mixer sets the recording levels of the input sources relative to all of the input sources. The combined input sources are then recorded as a single source (mixed).

Examples of Using the Audio Mixer

Below are some common examples of using the Audio Mixer.

• You can play a compact disc through the network computer’s speaker (Line In) and use the Audio Mixer to control the volume.
• When recording an audio file using the Audio Player, you can open the Audio Mixer client and adjust the Line In Gain volume so that you can monitor the file as it records. (You are not required to use the Audio Mixer when recording an audio file.)

• To selectively record specific segments of an audio source, adjust the Audio Player so that it is ready to record, open the Audio Mixer, and begin playing the audio source. When a segment plays that you want, start recording. When finished, stop the recording while still listening to the audio source. When another segment starts that you want to record, begin recording again. This allows you to selectively record only what you want without having to start and stop the audio source.

• To record multiple inputs, set the input source on the Audio Player to Mixed. The Audio Mixer now controls the recording volume of each of the input sources. For example, to record a presentation with background music and your voice, set the Line In Gain to a lower level than the Microphone Gain. (The Line In Gain controls the music volume, and the Microphone Gain controls the recording volume of your voice through the microphone.) Set the recording settings on the Audio Player, start recording the music and begin speaking into the microphone. When finished, stop the recording and play back the audio file. Re-adjust the levels on the Audio Mixer and re-record until the relative gains are correctly set.

Keep in mind that after the relative gains for the input sources are set with the Audio Mixer, you can then use the Recording Level feature on the Audio Player to adjust the multiple sources as a single source at a higher or lower level.

### Saving the Audio Mixer Level Settings

To save the level settings from one Audio Mixer session to another, note the dB values for the Line In Gain, Digital Gain, and Microphone Gain and add them to the `start AUDIO_SERVER` command in the remote configuration file (xp.cnf). The next time the Audio Mixer starts, the dB values are preset.

### Closing the Audio Mixer

To close the Audio Mixer, select the `Quit` command from the File menu.
Digital Video Player

The Digital Video player allows you to play video files in a video window on your network computer. The video file must be in MPEG file format. When started, the Video Player displays as shown below.

![Video Player Interface](image)

**Figure 4-9 Video Player.**

The following information about the Video Player is available:

- *Starting the Video Player* provides information about the various ways of starting the Video Player
- *Opening a Video File* provides information about opening video files
- *Using the Video Player* provides the steps for playing video files
- *Multicast* provides information about sending packets from a single point to multiple receivers
Starting the Video Player

The video player can be started from the Client Launcher, from the remote configuration file, or with xpsh.

Starting the Video Player from the Client Launcher

From the Multimedia submenu, select Digital Video. The Video Player displays as shown in Figure 4-9.

Starting the Video Player from the Remote Configuration File

The start DIGITAL_VIDEO command in the remote configuration file (xp.cnf) can be used to automatically download and start the Video Player when the network computer boots. Refer to the start command in Chapter 2 of the Tektronix NC200/NC400 Network Computer Reference manual for details.

Starting the Video Player with xpsh

xpsh can start the Video Player client, as shown in Figure 4-9. To open the Video Player with xpsh, enter the following:

```
xpsh -display nc_name:0 vplay
```

The following vplay options can be set on the xpsh command line:

- `-h host` — specifies the host name or address on which the video file resides. The host must be entered in the network computer’s Internet Host Table in Setup. This host displays in the Video Player’s File Information area.

- `-f filename and path` — specifies the video file name and its entire path. This file displays in the Video Player’s File Information area.

- `-a access method` — specifies the access method used to access the video file. Available access methods are tftp, nfs, dap and multicast. NFS is the preferred file access method for faster and more accurate data transfer rates required by the player. In addition, there is a 16MB limit on files transferred with TFTP.

- `-v volume level` — specifies the volume level to use when playing the video file. Specify a number between 0 and 100, with 0 indicating no volume, and 100 indicating the loudest volume setting.

- `-m (Mute)` — specifies that the video file plays with no sound.
Chapter 4  Using Advanced Features

-c (Color) — specifies that the video file displays in color (used only if the video was recorded in color).

-nc (No Color) — specifies that the video file displays in greyscale images.

-b (Big) — specifies that the video file displays in a frame four times the size of the original file.

-p (Play only) — when used with the -h, -f, -a, and -v options, the specified file plays without showing the Video Player. The entire file plays and cannot be interrupted.

-all (Play All; software player only) — plays all frames in a video file. Frame scheduling is ignored and the audio will not be in sync.

-title “string” — assigns a title for the vplay windows.

-propcmd — creates properties that allow other clients to send command strings to the Video Player. These properties can be used to control the Video Player from another client. For details about the properties, see the vplay man page.

-brightness n — sets the brightness level of the video file. Specify a number between -50 and +50.

-contrast n — sets the contrast level of the video file. Specify a number between -50 and +50.

-BUFSIZE n — (hardware player only) specifies the size of the Video Player’s memory buffer (in kilobytes). The value defaults to 1024 and can not be set lower than 1 kilobyte. If the value specified is greater than available memory when trying to play a file, the Video Player reduces its buffer to the available memory.

-CHKSIZE n — (hardware player only) specifies that the Video Player’s memory buffer is divided into “chunks”, measured in kilobytes. The network fills the chunks, and the Video Player empties them as they are accessed. The default is 32, which divides the buffer into 32 kilobyte chunks. If the chunk size is set to a number larger than the buffer size, the chunk size will be truncated to one half the buffer size. The chunk size cannot be set less than 1 kilobyte.

-CHKDELAY n — (hardware player only) specifies the time delay (in milliseconds) that the Video Player waits following each read request that fills a chunk.
Examples

This example opens the Video Player on the network computer named sierra:

```
xpsh -display sierra:0 vplay
```

This example opens the Video Player with the host portland and the video file /usr/adam/scene.mpg preloaded in the Video Player’s File Information Area:

```
xpsh -display sierra:0 vplay -h portland -f /usr/adam/scene.mpg -a tftp
```

This example plays the video file /usr/adam/scene.mpg (located on the host portland) in color and with no sound on the network computer without showing the Video Player:

```
xpsh -display sierra:0 vplay -h portland -f /usr/adam/scene.mpg -a tftp \ 
-c -m -p
```
Chapter 4   Using Advanced Features

Opening a Video File

The *Open* command on the File menu opens and displays an existing video file. Video files must be in MPEG file format only.

1. Select the *Open* command from the File menu. The File Selection window appears.

2. To select the access method to use, position the mouse pointer on the NFS button and click. A drop down menu displays the available methods: TFTP, NFS, or DAP. The File Selection window changes to reflect the chosen access method.
Using TFTP Access

The following File Selection window displays when tftp is the access method.

NOTE: Use tftp as the access method only if NFS is not available. NFS provides better and more accurate data transfer rates required to maintain continuous audio and video stream.

If using tftp as the access method, and you attempt to play a file that is greater than 16MB of MPEG data, the Digital Video Player ignores the remaining data after 16MB has been reached.
Chapter 4 Using Advanced Features

In addition, inherent limitations in tftp prevent fast forward and fast rewind from being supported.

1. Enter the name or address of the host on which the file is located in the Host field.

2. Enter the file’s path, filename, and extension in the Path field. The file must be an MPEG file.

3. Click OK. The host and file names display in the File Information Area.
Using NFS Access

The following File Selection window displays when NFS is the access method.

1. Enter the NFS mount point in the Filter field.
2. Click on the Apply Filter button. All subdirectories and files are listed in the Directories and Files areas.
3. To view files in a different directory, click on the directory name in the Directories area, and then click on the Apply Filter button. The files in that directory are listed in the Files area.
4. Select the file you want in the Files area. The full path and filename prefills in the Selection field. The file must be an MPEG file.
5. Click OK. The host and file names display in the File Information Area.

**Using DAP Access**

The following File Selection window displays when DAP is the access method.

1. Enter the node name or address in the Node field. This is the node on which the file is located.
2. Enter the file’s path and directory in the Filter field.
3. Click on the Apply Filter button. All subdirectories and files are listed in the Directories and Files areas.
Using DAP Access

4. To view files in a different directory, click on the directory name in the Directories area, and then click on the Apply Filter button. The files in that directory are listed in the Files area.

5. Select the file you want in the Files area. The full path and filename prefills in the Selection field. The file must be an MPEG file.

6. Click OK. The host and file names display in the File Information Area.
Playing a Video File

After opening the video file using the Open command, use the Control Buttons to play the file:

1. Click on the Play button to start playing the specified file. The video player plays MPEG files only.

   **NOTE:** If the file does not play, check the Console for messages. If the file is not an MPEG file format, the console displays the following message: `<FileName> is not an mpeg file!`

   If the video file includes audio, the Audio Player must be set to a sample frequency rate of 8000Hz. Otherwise, the audio will not play.

2. To stop playing the file, click on the Stop button.

3. To rewind the video file to the beginning of the file, click on the Rewind button.

4. To advance one frame at a time, click on the Forward button. This button is not available if using TFTP as the file access method.

5. To fast forward through the file, click and hold the Fast Forward button. Release the button when you want to stop. Refer to the Fast Forwarding and Rewinding topic on page 4-35 for more information.

6. To fast rewind through the file, click and hold the Fast Rewind button. Release the button when you want to stop. Refer to the Fast Forwarding and Rewinding topic on page 4-35 for more information.

7. To adjust the volume, slide the volume controller to the right to increase the volume, or to the left to decrease the volume. Be sure the Sound button is on, or pushed in. The Sound button acts as a mute toggle; when it is pushed in, you can hear the sound, when it is off, the sound is muted.
Fast Forwarding and Rewinding

While playing the video file, use the following controls to adjust the size and color of the video file.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Plays the video in the size it was recorded (1X), or in a video window four times the size it was recorded (4X).</td>
</tr>
<tr>
<td>Black/White</td>
<td>Plays the video in color, or in greyscale. Turn this option on to play the file in black and white, or off to play the file in color.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Sets the contrast level. Slide the level indicator to the left to decrease contrast levels, or to the right to increase the contrast levels.</td>
</tr>
<tr>
<td>Brightness</td>
<td>Sets brightness level. Slide the level indicator to the left to decrease brightness levels, or to the right to increase the brightness levels.</td>
</tr>
</tbody>
</table>

Fast Forwarding and Rewinding

The Fast Forward and Fast Rewind functions allow you directly access any part of a video file. By using the Video Player’s Fast Forward and Fast Rewind buttons or position slider, you can start playback from any location in a file, or replay a portion of a file any number of times, without having to start at the beginning.

*NOTE: The Fast Forward, Fast Rewind, and Position Slider are not available if using TFTP as the file access method.*

The slider (NFS only) and time-code window let you see how much of a file has already played. The slider represents a time index corresponding to the time code embedded in the MPEG stream. If the stream begins at zero, the time code acts as a simple timer of how long the video is. Whether you use the buttons or slider, the time-code window displays the time code of the current frame location in hours, minutes, and seconds. Both the slider and window are updated dynamically during playback.

To fast forward or fast rewind using the position slider, do the following:

1. Using any mouse button, grab and drag the slider to the right to fast forward or to the left to rewind.

2. Release the button when you reach the desired location.
To fast forward or rewind using the Video Player’s buttons, do the following:

1. Using any mouse button, press and hold the fast forward or fast rewind button.

2. Release the button when you reach the desired location.

As you drag the slider or press the fast forward or fast rewind button, the video window is updated, displaying intermediate video portions. When you release the slider or button, the video player returns to its previous state. For example, if a video was playing when you repositioned the slider or pressed the button, the video restarts when you release it. If a video was on pause, it remains on pause.

As mentioned, you can use any mouse button to drag the slider. However, if you click on the first mouse button when the mouse is within the position slider track (but not on the slider button), the slider moves a tiny bit to that side of the slider button, no matter where in the track you place it. Essentially, the video is repositioned to the nearest MPEG Group of Pictures (GOP) boundary (generally about 1/2 second). If you press the second mouse button when it’s in the slider track, the file is positioned at that location.

**Multicast**

Multicast is a way to send packets from a single point to multiple receivers. The receivers can determine when and if they receive the Multicast packets. Multicast video takes advantage of networks that support Multicasting to decrease network bandwidth and provide a means of easily accessing video information.

The Digital Video player allows you to play video files in a video window on your network computer using Multicast. The video file must be in MPEG file format.

*NOTE: Multicast is only available on Series 400 network computers.*

**Channels**

Channel changing is an interface that maps “channel” numbers to Multicast addresses. This mapping is made in the remote configuration file (*xp.cnf*) and remains fixed until the network computer is rebooted.
Selection of a channel causes the client to cease reception on any current channel and attempt to join a transmission in progress on the selected channel. The client begins reading data from the Multicast IP address. When it reads sufficient data to properly set up the window size, the view window resets its size. A default sized window is started before this happens.

**Choosing Multicast Channels**

1. Edit the `video_multicast_entry` command line in the remote configuration file (`xp.cnf`) to set your Multicast channel options. (Refer to the `video_multicast_entry` command in Chapter 2 of the Reference Manual.) These channels display on the Video Player’s Multicast menu option. If you omit this step, the Video Player does not display the Multicast menu.

2. In the Video Player, click on the Multicast menu to display the available channels.

3. Select the channel from the Multicast menu. The Video Player starts as soon as something is received on that channel.

The example below has two parts. The first part sets up the channels “Blues Channel”, “Rock Channel”, and “News Channel” using the `video_multicast_entry` command in the `xp.cnf` file.

```
video_multicast_entry “224.200.50.10” “3000” “Blues Channel”
video_multicast_entry “224.200.50.11” “3000” “Rock Channel”
video_multicast_entry “224.200.50.11” “3001” “News Channel”
```

The second part of the example starts a Multicast session and plays the second Multicast channel in the Multicast channel array (in this example, “Rock Channel”) set in the remote configuration file (`xp.cnf`).

```
xpsh -display twinkle:0 vplay -chan 2
```
Chapter 4 Using Advanced Features

Multicast Options

The following Multicast options can be added to the `xpsh` command line when starting the Digital Video Player:

**NOTE:** Where indicated, the following `vplay` options apply to both broadcast and Multicast, though in different ways. Only information relevant to Multicasting is included below.

- **-h host** — specifies the Multicast IP address. This address must be the same as the address being used by the Multicast server. See your system administrator for valid choices. The address displays in the Video Player’s Addr/Port Information Area.

- **-f filename** — specifies the Multicast port number. This port number must be the same as the port number being used by the Multicast server. See your system administrator for valid choices. The port number displays in the Video Player’s Addr/Port Information Area.

- **-chan n** — specifies an index into an array of available Multicast channels. (Refer to the Channels topic above and video_multicast_entry in Chapter 2 of the Reference manual.) Do not use with the `-h`, `-f`, `-a`, or `-text` options.

- **-text “string”** — specifies the channel string displayed by the Video Player. Do not use with the `-chan` option.

- **-a access method** — specifies the access method used to access the video file. Use Multicast when Multicasting.

Example

This example starts the Video Player and plays the video being Multicast on IP address 224.200.50.1, port 3000. The Video Player displays the text “The Blues Channel”.

```
xpsh -display twinkle:0 vplay -h 224.200.50.1 -f 3000 \
   -a MULTICAST -text “The Blues Channel”
```

The Video Player opens displaying the Multicast menu as shown in the figure below.
Closing the Video Player

When viewing a Multicast video, the Forward, Fast Forward, Rewind, and Fast Rewind buttons are not operational. However, the time index (displayed in the Time Code Window) shows the current time code within the current video segment of the Multicast video. You can note the video segment number and load it at a later time as a file, reposition to a specific location, and review a segment of the video previously seen during a Multicast session.

Closing the Video Player

To close the Video Player, select the Quit command from the File menu. Any open file information is saved and the player exits.
Chapter 4  Using Advanced Features

Analog Video Player

The Analog Video Player enables you to view NTSC (National Television System Committee) or PAL (Phase Alternation Line-rate) sources in a window on the network computer’s display. Common NTSC and PAL video sources are VCR’s, video disc players, video cameras, and television tuners. When viewing a video on the network computer, you can control the volume, window size and placement, and color settings. When started the Analog Video Player displays as shown in Figure 4-13.

Figure 4-11 Analog Video Player.

The Analog Video player requires the analog hardware. Not all network computer models have the analog hardware.

Before using the Analog Video Player, the xv server extension must be enabled. If the analog hardware is present, the xv server downloads automatically when the network computer boots. If for some reason the xv server extension is disabled, use the enable_xv command in the remote configuration file to enable it. Refer to Chapter 2 Remote Configuration in the TekXPress Reference Manual for details.
Analog Video Player

The following information about the Analog Video Player is available:

- *Starting the Analog Video Player* provides information about the various ways of starting the Analog Video Player

- *Connecting the Network Computer to an Analog Video Device* provides information about the ports on the network computer and connecting the video device

- *Using the Analog Video Player* provides the steps for viewing analog video sources
Starting the Analog Video Player

The Analog Video Player can be started from the Client Launcher, from the remote configuration file, or with `xpsh`.

Starting the Analog Video Player from the Client Launcher

From the Multimedia submenu, select Analog Video. The Analog Video Player displays as shown in Figure 4-13.

Starting the Analog Video Player from the Remote Configuration File

The `start ANALOG_VIDEO` command in the remote configuration file (`xp.cnf`) can be used to automatically download and start the Analog Video Player when the network computer boots. Refer to the `start` command in Chapter 2 of the TekXPress Reference manual for details.

Starting the Analog Video Player with `xpsh`

`xpsh` can start the Analog Video Player client, as shown in Figure 4-13. To open the Video Player with `xpsh`, enter the following:

```
xpsh -display nc_name:0 xpvideo
```

The following options can be set on the `xpsh` command line:

- `-encode` specifies the encoding format. Specify either NTSC, which is commonly used in the United States; or PAL, commonly used in Europe.
- `-source` specifies the video source to which the video device is connected. Specify either COMPOSITE_1, COMPOSITE_2 or SVIDEO1.
- `-color` specifies the color intensity of the video being played. Specify a number from -1000 to 1000. 0 is the default.
- `-bright` specifies the color brightness intensity of the video being played. Specify a number from -1000 to 1000. 0 is the default.
- `-contrast` specifies the color contrast intensity of the video being played. Specify a number from -1000 to 1000. 0 is the default.
- `-tint` specifies the color tint of the video being player. Specify a number from -1000 to 1000. 0 is the default.
Connecting The Network Computer to an Analog Video Device

To use the Analog Video Player, first connect the video device to the network computer. The Analog Video Player plays NTSC and PAL video encoded sources.

NOTE: Refer to your video source user manual for cabling and encoding information.

There are several ports on the back panel of the network computer used for analog video. Connect composite sources to the Port 1 Composite, Port 2 Composite, or Port 1 SVideo ports. Refer to Figure 4-12 for the location of the video ports.

NOTE: You cannot have two video devices connected to Port 1 Composite and Port 1 SVideo at the same time.
Chapter 4  Using Advanced Features

Using the Analog Video Player

When the audio device is connected, you are ready to view the video on the network computer. When started, the Analog Video Player displays the video options as shown in Figure 4-13. (The Video button on the player is depressed.)

![Figure 4-13 Analog Video Player - Video Options.](image)

To play a video on the network computer:

1. Connect the video source to the network computer. Refer to the Connecting the Network Computer to a Video Source section.

2. Click on the Play button. A separate XPVIDEO window displays which is used to view the video. (This does not affect the video source. You must start the video source with its own play function.) The icon below the File menu changes to include a viewer window. If the viewer window is obstructed by other windows, clicking on this icon brings the viewer window to the top.

3. To adjust the volume, slide the volume controller to the right to increase the volume, or to the left to decrease the volume. Be sure the Sound button is on, or pushed in. The Sound button acts as a mute toggle; when it is pushed in, you can hear the sound, when it is off, the sound is muted.
4. To freeze a frame, click on the Pause button. This displays the frame in the viewer window, however, has no effect on the video source and it continues to play. Click on the Play button to resume viewing the video source.

5. To stop viewing the video, click on the Stop button. This has no effect on the video source and it continues to play.

While viewing a video, you can control the following window attributes:

- **Brightness**
  - Sets the brightness level. Slide the level indicator to the left to decrease brightness levels, or to the right to increase the brightness levels.

- **Color**
  - Sets the color level, or intensity. Slide the level indicator to the left to decrease color intensity, or to the right to increase the color intensity.

- **Contrast**
  - Sets the contrast level. Slide the level indicator to the left to decrease contrast levels, or to the right to increase the contrast levels.

- **Tint/Hue**
  - Sets the tint, or hue, levels. Slide the level indicator to the left to decrease the tint/hue levels, or to the right to increase the tint/hue levels.

- **Restore**
  - Restores the video player options to the default settings.

- **View Menu**
  - The View Menu contains the ResetSize command. This command returns the viewer window to its default size.

Clicking on the Settings button displays the Settings options as shown in Figure 4-14.
NOTE: The Tuner options are not available at this time.

Figure 4-14  Analog Video Player - Settings Options.

These settings can be changed:

<table>
<thead>
<tr>
<th>Source</th>
<th>Encoding</th>
<th>Field Duplicate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port 1 - Composite</td>
<td>NTSC</td>
<td>Dis-</td>
</tr>
<tr>
<td>Port 2 - Composite</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Port 1 SVideo</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Black/White Specifies whether the image in the viewing window displays in color or in black and white.

Auto Gain Control Specifies the Automatic Gain Control setting. When turned ON, the video signal is automatically amplified for best picture quality.
### Aspect Ratio
Specifies the window sizing attributes. Aspect ratio is when the relative proportion of the video window’s width and height is preserved when re-sizing the window. When ON, the window size is automatically adjusted to preserve the aspect ratio. If OFF, you can re-size the window to any size and the aspect ratio will not be maintained.

### Overscan
Specifies whether the image in the viewer window is in overscan mode. If ON, the full image displays. If OFF, the image is reduced by 10% to match the viewing area of typical consumer television screens.

### Field Duplicate
Specifies whether the Analog Video Player uses field duplication. Field duplication is used primarily to eliminate blurred images when viewing fast motion videos or images generated by graphics systems such as video games. AUTO specifies that the player determines whether to use field duplication based on the video window size.

### Horizontal
Positions the contents of the view window horizontally. Slide the indicator to the left or right to move the contents of the viewer window left and right.

### Vertical
Positions the contents of the view window vertically. Slide the indicator to the left or right to move the contents of the viewer window up and down.

### View Menu
The View Menu contains the ResetSize command. This command returns the viewer window to its default size.

---

### Closing the Analog Video Player

To close the Analog Video Player, select the *Quit* command from the File menu.
The XIE Viewer

The XIE viewer displays an image file using the XIE protocol. The viewer allows you to manipulate a displayed image in the following ways:

- Select pages when a multiple page file is loaded
- Rotate the image window by 0, 90, 180 and 270 degrees
- Zoom (enlarge) an area of an image

When started, the XIE Viewer displays as shown below.

![Figure 4-15 XIE Viewer.](image-url)
The XIE Viewer supports the following formats:

tif — TIFF image file
tiff — TIFF image file
gif — GIF87a format
gjpg — MPEG file interchange format
cjpg — MPEG file interchange format
jif — MPEG file interchange format
bmp — Bitmap format
pnm — Portable Bitmap format
pgm — Portable Graymap format
ppm — Portable Pixmap format
bpcm — bitonal pcm
bg31 — bitonal G31D compressed
bg32 — bitonal G32D compressed
bg42 — bitonal G42D compressed
gpcm — greyscale pcm
cpcm — color (rgb) pcm
fax — raw G3 fax with no headers

---

**Starting the XIE Viewer**

The XIE Viewer can be started from the *Client Launcher*, from the remote configuration file, or with *xpsh*.

*NOTE: XIE requires an authorization key. XIE must also be enabled before using the XIE viewer.*

**Starting the XIE Viewer from the Client Launcher**

From the Multimedia submenu, select XIE Viewer. The XIE Viewer displays as shown in Figure 4-15.

**Starting the XIE Viewer from the Remote Configuration File**

The `start XIEVIEW` command in the remote configuration file (*xp.cnf*) can be used to automatically download and start the XIE Viewer when the network computer boots. Refer to the start command in Chapter 2 of the *Tektronix NC200/NC400 Network Computer Reference* manual for details.
Starting the XIE Viewer with xpsh

xpsh can open the XIE Viewer client, as shown in Figure 4-15. To open the XIE Viewer with xpsh, enter the following:

```
xpsh -display nc_name:0 xieview
```

The following options can be set on the xpsh command line:

- **-ifg color** specifies the color used as the foreground on bitonal images. The color specified must be in the network computer’s rgb.txt file.

- **-ibg color** specifies the color used as the background on bitonal images. The color specified must be in the network computer’s rgb.txt file.

- **-cc color** specifies the background color for the image window. The color specified must be in the network computer’s rgb.txt file.

- **-f filename and path** specifies the XIE file name and its entire path. This file displays when the XIE Viewer is started. The file name and path is displayed in the File Information Area on the XIE Viewer client.

- **-fullpan True or False**
  
  If True, the image uses less memory when zoomed. If False, the image uses more memory when zoomed. When set to False, panning the image is faster. If there is not enough memory to view the entire zoomed image, only part of the image will be available when panning. The default is True.
Opening and Displaying an Image File

The *Open* command on the File menu opens and displays an existing XIE file in a separate viewing window.

1. Select the *Open* command from the File menu. The File Selection window appears.

2. To select the access method to use, position the mouse pointer on the NFS button and click. A drop down menu displays the available methods: TFTP, NFS, or DAP. The File Selection window changes to reflect the chosen access method.
Chapter 4 Using Advanced Features

Using TFTP Access

The following File Selection window displays when tftp is the access method.

NOTE: If using tftp as the access method to display an image file, the XIE Viewer cannot display a file that is greater than 16MB. If you attempt to view a file larger than 16MB, the viewer will ignore the file.

Use tftp as the access method only if NFS is not available. NFS provides better and more accurate data transfer rates required to maintain continuous data stream.
1. Enter the name or address of the host on which the file is located in the Host field.

2. Enter the file’s path, filename, and extension in the Path field. Files with the following extensions can be viewed on the XIE Viewer:
   - gif — GIF87a format
   - jpg — JPEG file interchange format
   - gjpg — JPEG file interchange format
   - cjpg — JPEG file interchange format
   - jfif — JPEG file interchange format
   - bmp — Bitmap format
   - pbm — Portable Bitmap format
   - pgm — Portable Graymap format
   - ppm — Portable Pixmap format
   - bpcm — bitonal pcm
   - bg31 — bitonal G31D compressed
   - bg32 — bitonal G32D compressed
   - bg42 — bitonal G42D compressed
   - gpcm — greyscale pcm
   - cpcm — color (rgb) pcm
   - fax — raw G3 fax with no headers

   **NOTE:** TIFF and TIF images require random access capability and tftp does not support random access. To view TIFF or TIF files, use NFS as the access method.

3. Click OK. The host and file names display in the File Information Area, and the image displays in a separate view window. If the file does not appear, look in the Console for status messages.

Using NFS Access

The following File Selection window displays when NFS is the access method.
1. Enter the NFS mount point in the Filter field.

2. Click on the Apply Filter button. All subdirectories and files are listed in the Directories and Files areas.

3. To view files in a different directory, click on the directory name in the Directories area, and then click on the Apply Filter button. The files in that directory are listed in the Files area.
4. Select the file you want in the Files area. The full path and filename prefills in the Selection field. Files with the following extensions can be viewed on the XIE Viewer:

- tif — TIFF image file
- tiff — TIFF image file
- gif — GIF87a format
- jpg — JPEG file interchange format
- gjpg — JPEG file interchange format
- cjpg — JPEG file interchange format
- jfif — JPEG file interchange format
- bmp — Bitmap format
- pbm — Portable Bitmap format
- pgm — Portable Graymap format
- ppm — Portable Pixmap format
- bpcm — bitonal pcm
- bg31 — bitonal G31D compressed
- bg32 — bitonal G32D compressed
- bg42 — bitonal G42D compressed
- gpcm — greyscale pcm
- cpcm — color (rgb) pcm
- fax — raw G3 fax with no headers

5. Click OK. The host and file names display in the File Information Area, and the image displays in a separate view window. If the file does not appear, look in the Console for status messages.

**Using DAP Access**

The following File Selection window displays when DAP is the access method.
Chapter 4 Using Advanced Features

1. Enter the node name or address in the Node field. This is the node on which the file is located.

2. Enter the file’s path and directory in the Filter field.

3. Click on the Apply Filter button. All subdirectories and files are listed in the Directories and Files areas.
Using DAP Access

4. To view files in a different directory, click on the directory name in the Directories area, and then click on the Apply Filter button. The files in that directory are listed in the Files area.

5. Select the file you want in the Files area. The full path and filename prefills in the Selection field. Files with the following extensions can be viewed on the XIE Viewer:

- tif — TIFF image file
- tiff — TIFF image file
- gif — GIF87a format
- jpg — JPEG file interchange format
- gjpg — JPEG file interchange format
- cjpg — JPEG file interchange format
- jff — JPEG file interchange format
- bmp — Bitmap format
- pbm — Portable Bitmap format
- pgm — Portable Graymap format
- ppm — Portable Pixmap format
- bpcm — bitonal pcm
- bg31 — bitonal G31D compressed
- bg32 — bitonal G32D compressed
- bg42 — bitonal G42D compressed
- gpcm — greyscale pcm
- cpcm — color (rgb) pcm
- fax — raw G3 fax with no headers

6. Click OK. The host and file names display in the File Information Area, and the image displays in a separate view window. If the file does not appear, look in the Console for status messages.
Chapter 4  Using Advanced Features

Viewing Options

The image from the file is displayed in a separate XIE Viewer window. Use the following XIE Viewer options when viewing an image:

1. To display the first page in a multi-image file, click on the First Page button.

2. To display the last page in a multi-image file, click on the Last Page button.

3. To display the next page in a multi-image file, click on the Next Page button.

4. To display the previous page in a multi-image file, click on the Previous Page button.

5. To rotate the image, click on the Rotation button, either 90, 180, 270, or 0. Rotation of the image will not resize the XIE Viewer window. When an image is rotated, zoomed images are returned to normal size.

   Enhanced  Enables anti-aliasing of the image. This may result in improved readability of the image.

   100%  This button removes the effect of zooming.

   Page  Displays other pages in a multi-image file. Move the slider to the right and left to view other pages in the file. The current page number displays in the Page field.

   Zooming  To zoom the image, position the mouse pointer at some point in the image, then click and drag over the desired area. A rectangle appears over the image to indicate the selected area. When you release the mouse button, the selected area is scaled up to fit the window. You can zoom an image any number of times. Scroll bars on both the right and bottom of image display window allow you to pan the enlarged image.

Closing the XIE Viewer

To close the XIE Viewer, select the Quit command from the File menu. Any open file information is saved and the player exits.
WinDD

The WinDD client provides access to PC servers running WinDD software. Once you are logged in to the PC server, you can run Windows NT and DOS based applications.

NOTE: DOS graphics applications are not supported (even if started from the DOS Command Prompt in the Main folder). DOS applications can only be run in character (text) mode. Refer to each application for startup options to invoke the application in this mode. If you try to run a DOS graphics application, an error is generated and the application terminates.

Starting Local WinDD

WinDD can be started using the Client Launcher, HostMenu, the remote configuration file or from the command line with xpsh.

Starting WinDD from the Client Launcher

From the Host Connections submenu, select WinDD. The WinDD local client is illustrated in Figure 2-14.

Starting WinDD from HostMenu

Click the WinDD button (if necessary) to access the WinDD list. Click on a server, or enter the server name or address in the Application Server box.

Starting WinDD with xp.cnf

The start WINDD command in the remote configuration file (xp.cnf) automatically downloads and starts WinDD when the network computer boots. Refer to the start command in Chapter 2 of the TekXPress Reference manual for details. Related WinDD remote configuration commands include:

- host_connect_method
- windd_menu_entry
- windd_auto_reconnect
- default_windd_host
- windd_menuubar
- start
- flash_feature
- windd_keysym_only

   default_host_list
   windd_auto_connect
   windd_size
   windd_host_entry
   windd_entrybox
   preload
   windd_auto_numlock
   windd_exit_on_logout
Chapter 4 Using Advanced Features

Starting WinDD with xpsh

xpsh starts the local WinDD client as needed. Enter the following (where nc_name is the name or address of your network computer):

```
  xpsh -display nc_name:0 windd [options]
```

The following options can be set on the xpsh command line. If an option is not specified, the default setting is used.

- **-display nc:0**
  Specifies the network computer (nc) name or address to display the WinDD local client.

- **-c**
  Auto-connect to the first application server in the application server list. If there are no application servers in the list, this option is ignored and the client window is displayed.

- **-nc**
  Do not auto-connect to an application server. (Default)

- **-d**
  Displays the menu bar and the internal borders. (Default)

- **-nd**
  Does not display the menu bar or the internal borders. For example, this allows a 1280x1024 WinDD window to fully display on a 1280x1024 monitor (minus windows manager decorations).

- **-e**
  Enables the Application Server edit field window so that users can add application servers to the application server list. (Default)

- **-ne**
  Disables the Application Server edit field window so that users are not allowed to add application servers to the application server list.

- **-floppy**
  Allows supported host versions of WinDD to use its local floppy drive as a network connected drive for the Application Server. Only the first host client to specify this option will be allowed to use the floppy device. NOTE: For host clients (with local floppy drive) only.

- **-no_floppy_cache**
  Disables use of local floppy write cache. This is a fail-safe option to ensure the entire file has been updated in the event a user suddenly ejects a disk mechanically (when disks are ejected via the GUI button, that process flushes the cache so no information is lost).

- **-geometry <geometry>**
  Standard X11 geometry option, <WidthxHeight+X+Y>.
-h <application server>
  Adds the named application server(s) to the application server list. Multiple application servers can be added to the list by listing them separated by spaces.

-help
  Displays a brief help list on the available WinDD command line options.

-initprog <prog> [-initdir <dir>]
  Specifies the application to execute upon application server login. The login session is terminated when the application is terminated.

  Prog specifies the application and can also specify its path (up to 259 characters) and parameters. The program path and name are written consecutively (and not separated by a space) when they are both specified in prog. A space separates the program name and its parameters. These parameters are program specific and can specify program settings or data files to invoke on execution.

  Dir specifies the path of the executable program.

-keysym_only
  Specifies that all Tektronix network computer keyboards are supported with keysym translations within WinDD.

-local_numlock
  Specifies that WinDD manages the state of the Num_Lock independent of any Xserver support.

-no_auto_numlock
  Specifies that WinDD does not control the Num_Lock setting.

-login <username> [pass <passwd>] [-domain <domainname>]
  Specifies the application server user account login name, login password, and domain. These values will be used for user account verification.

  When using a WinDD client and connecting to a WinDD application server, your username, password, domain, initial program, and initial directory are encrypted as they are sent across the network.

  Username, password, domainname, dir, and prog are not viewable or changeable from the WinDD configuration window.
Chapter 4  Using Advanced Features

- Reconnect to the application server after log off.
- Does not reconnect to the application server after log off. (Default)
- Displays the WinDD version in use. (If the license is 8019, this option also prints For evaluation purposes only.)
- Exits the WinDD client upon logging out of, or disconnecting from, the application server.
- Does not exit the WinDD client upon logging out of, or disconnecting from, the application server. (Default)
- Specifies that monochrome pointers within the WinDD desktop are to be implemented using X cursors. Some monochrome pointers are xor’d with the underlying desktop. When this switch is specified, it is no longer xor’d, as X cursors do not support that mode.

**NOTE:** The force_xcursor feature is intended to compensate for workstations that do not have a particularly high performance X server. Consider using this option if the pointer flashes when move, or poor performance is observed entering text in dialog boxes. Using this switch improves user interactivity. The only side effect is the pointer is displayed in a single color.
Configuring your WinDD Session from the Client Screen

From the WinDD client screen (Figure 4-16), you can easily change your session attributes before you log in to a server.

The Configure button brings up the WinDD Resolution dialog box illustrated in Figure 4-17. The resolution determines the size of the WinDD window. The resolution must be selected prior to making a connection to the application server and cannot be interactively changed until the connection has been closed. The Configure button performs the same function as the Options ⇒ Configure pull down menu choice.
Chapter 4  Using Advanced Features

Figure 4-17  WinDD Configuration Dialog Box.

The **Reconnect After Logoff** button enables automatic reconnection to the application server after you have logged off of a WinDD session. If this button is on, then the WinDD log in screen (Figure 2-16) appears when you select File ⇒ Logoff from a Windows NT session. If this button is off, the WinDD client screen is displayed when you log off a session.

WinDD messages about connection status, error conditions, or other necessary user feedback appear in the message console area. All message are also sent to the network computer system console so that the information is available even if WinDD has been terminated. Use the **Clear Console** button to clear messages.

When configuration is complete, select the application server for your session.

**Selecting an Application Server**

The WinDD client screen displays a list of application servers your system administration defined for you. Use the mouse to select one of the servers from the list. If the application server you want to access is not on the list, enter the name or address in the Application Server: field and press Enter. WinDD log in information is in Chapter 2, *Operating the Network Computer*. 
WinDD Local Client Options Menu

There are two ways to access the local client Options menu:
1. Select Options from the local client menu bar (Figure 4-18).

<table>
<thead>
<tr>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log On</td>
<td></td>
</tr>
<tr>
<td>Send Ctrl+Alt+Del</td>
<td></td>
</tr>
<tr>
<td>Configure</td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
</tr>
</tbody>
</table>

Figure 4-18 Local Client Options Pull Down Menu.

2. Hold down Shift and Ctrl and click the middle mouse button (Figure 4-19). This method is only available after you have a server connection.

<table>
<thead>
<tr>
<th>WinDD Options Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log On</td>
</tr>
<tr>
<td>Ctrl+Alt+Del</td>
</tr>
<tr>
<td>Exit WinDD</td>
</tr>
</tbody>
</table>

Figure 4-19 Local Client Options Menu.
Chapter 4  Using Advanced Features

Log On

• Toggles between the WinDD session window and the WinDD client screen. This is only available after you have a server connection. The Cancel button on the client screen returns you to the session window.

Configure

• Brings up the WinDD Resolution dialog box (Figure 4-17). This is only available before you have a server connection.

Exit

• Closes the WinDD client.

WinDD Help Menu

About WinDD

• Displays WinDD copyright and version information.

NOTE: Refer to the WinDD User manual for additional feature and operating information.
PSXpress

After installing the Adobe software, add the following configuration information to the users’ environments (typically in their .login or .cshrc files). The contents of this section can also be found in the file user.adobe.

NOTE: Users’ execution path, X resources, and PostScript resources must be defined correctly for all of the Adobe software demos to work.

Changing Execution Paths

Add the following directory to the execution paths or PATH variables: /tekxp/bin/<host>, where <host> is sun, solaris, or hp.

For example, assuming that the installation location at your site is /export/tekxp, the following commands change a user’s execution path to run Adobe software on a SunOS 4.1.3 system:

```
# setenv PATH /export/tekxp/bin/sun4:"$PATH"
# rehash
```

Integrating Icons into an OpenWindows Desktop

To integrate Acrobat Reader icons into an OpenWindows desktop, run the olwm.deskinstall script. You can run this script as root, or from your login account.

If you are root, the binder rules are defined on a system-wide basis in /etc/cetables/cetables. If you run the script as a normal user, the binder rules are installed in $HOME/.cetables/cetables.

Follow these steps for system-wide installation:

1. In a UNIX shell window, as root, locate the olwm.deskinstall script:
   ```
   # cd /tekxp/AcroRead_2.1/desktop
   ```

2. Run the olwm.deskinstall script:
   ```
   # /olwm.deskinstall
   ```
   After the script has been installed, a message appears, indicating that you have successfully installed the software:

3. For the changes to take effect, log off of the OpenWindows window manager, and log back on.
Chapter 4  
Using Advanced Features

Using Display PostScript NX with Sun AnswerBook

To run AnswerBook on Solaris systems, first verify that:

• The Sun Patch version 101654-02 or later is present on your Solaris system.
• The DpsNx group was installed from the XpressWare media.

To run AnswerBook:

1. Add the following to the LD_LIBRARY_PATH environment variable:
   <install_directory>/tekxp/dpsnx_2.1/common/lib
   Add this line before the /usr/openwin/lib entry.

2. Set the display variable, where nc_name is the network computer’s name:
   # setenv DISPLAY nc_name:0

3. Run the execnx command:
   # execnx &

4. Run AnswerBook:
   # answerbook

X Resources and Application Defaults

Add the following template to the value of the user’s XFILESEARCHPATH variables:

/tekxp/dpsnx_2.1/common/app-defaults/%N.ad

PostScript Resources

Add the following directory to the user’s PSRESOURCEPATH environment variables. The PSRESOURCEPATH definitions should end with two colons (::):

/tekxp/dpsnx_2.1/common/psres

For example, if you want to use the applications in the PSXpress option and PSRESOURCEPATH has not been set, use the following command:

# setenv PSRESOURCEPATH /tekxp/dpsnx_2.1/common/psres::

It correctly sets the PSRESOURCEPATH variable.
Launching Applications

By default, Adobe Acrobat Reader and other applications are installed in `/tekxp/bin/{sun4|solaris|hp}`. Make sure this directory has been added to user’s execution search paths.

Table 4-1 lists the commands used to launch Adobe applications.

Table 4-1 Commands to Launch Adobe Applications.

<table>
<thead>
<tr>
<th>Application</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe ShowPS</td>
<td>showps</td>
<td>A viewer for PostScript documents and files.</td>
</tr>
<tr>
<td>Adobe Acrobat Reader</td>
<td>acroread</td>
<td>A viewer for Portable Document Format (PDF) files.</td>
</tr>
<tr>
<td>Display PostScript Executive</td>
<td>dpsexec</td>
<td>An interface that provides direct user interaction with the PostScript interpreter.</td>
</tr>
<tr>
<td>Motif Draw Demo</td>
<td>draw</td>
<td>A simple drawing editor with text, ellipses, and rectangles.</td>
</tr>
<tr>
<td>Motif Font Viewing Demo</td>
<td>fontview</td>
<td>A viewer for fonts available on the system.</td>
</tr>
<tr>
<td>Motif Graphical Text Demo</td>
<td>scratchpad</td>
<td>A graphical editor for manipulating text.</td>
</tr>
<tr>
<td>Display PostScript Text Game</td>
<td>texteroids</td>
<td>A game similar to asteroids, with rotating text.</td>
</tr>
<tr>
<td>Display PostScript Imaging Demo</td>
<td>wonderland</td>
<td>A demo that illustrates Display PostScript imaging capabilities.</td>
</tr>
<tr>
<td>EPSF Viewing Demo</td>
<td>xepsf</td>
<td>Viewer for Encapsulated PostScript Format files.</td>
</tr>
</tbody>
</table>
Launching Acrobat Reader

If you have configured OpenWindows as described in the Integrating Icons into an OpenWindows Desktop section, you will see the Acrobat Reader icon on your desktop. Click on the icon (or on a PDF document icon) to start Acrobat Reader.

To view one or more files while starting Acrobat Reader, give the file names as command line parameters. For example, to view /tekxp/AcroRead_2.1/sun/doc/Tour.pdf and /tekxp/AcroRead_2.1/sun/doc/Samples/Backgrndr.pdf, enter:

```
# acroread /tekxp/AcroRead_2.1/sun/doc/Tour.pdf \ /tekxp/AcroRead_2.1/sun/doc/Samples/Backgrndr.pdf
```

The acroread launch script and the acroread_frontend program ensure that only one version of Reader runs on your desktop. If you issue the command acroread filename.pdf when Reader is already running, the currently running version of Reader loads and displays filename.pdf.

If you want a new version of Reader each time you issue the acroread command, /tekxp/AcroRead_2.1/custom/USEFRONTENDPROGRAM or launch acroread as follows:

```
# acroread --e USEFRONTENDPROGRAM=0
```

Locating Acrobat Reader Preferences File

The preferences that are specified by the user through the Preferences Dialog are stored in a preferences file. Acrobat Reader reads this file at startup and writes this file every time the user clicks the OK button in the Preferences dialog.

The specific preferences file used by Acrobat Reader is determined by selecting the first non-directory file that can be located from a list of candidates. The candidate list is specified as a colon-separated list of path names. The path names may contain the special sequence %N to denote Acrobat Reader’s class name, which is Acroread. For example,

```
/user/joe/app-defaults/%N:/user/joe/%N
```

specifies two candidate preferences files, namely /user/joe/app-defaults/Acroread and /user/joe/Acroread.
Locating Acrobat Reader Preferences File

If this candidate list was used by Acrobat Reader to locate the preferences file, then if /user/joe/app-defaults/Acroread exists as a plain file, it will be used as the preferences file. Otherwise, if /user/joe/Acroread exists as a plain file, then it will be used.

If neither file exists, then the file /user/joe/app-defaults/Acroread, being the first candidate specified, will be created when Acrobat Reader writes the preferences file.

The content of the candidate list depends on two environment variables, XAPPLRESDIR and XUSERFILESEARCHPATH.

1. If neither XAPPLRESDIR nor XUSERFILESEARCHPATH is set in the user’s environment, then the candidate list is $HOME/%N, where $HOME denotes the user’s home directory.

2. Otherwise, if XUSERFILESEARCHPATH is set, then the value of XUSERFILESEARCHPATH is used as the candidate list. For example, the user could get the candidate list specified in the example above by entering the following C-shell command:

   # setenv XUSERFILESEARCHPATH /user/joe/app-defaults/%N:/user/joe/%N

3. Otherwise the candidate list will be $XAPPLRESDIR/%N:$HOME/%N, where $XAPPLRESDIR denotes the value of the XAPPLRESDIR environment variable.

If users have a file named Acroread in their home directories, then they need not specify an XAPPLRESDIR or XUSERFILESEARCHPATH environment variable.

The following single entry in a user’s .cshrc file will cause applications to look for the appropriate preferences files in the app-defaults subdirectory of the user’s home directory:

   setenv XUSERFILESEARCHPATH $HOME/app-defaults/%N

The complete set of rules for determining the candidate list can be found in The X Window System Toolkit, published by Digital Press.
Chapter 4  Using Advanced Features

Printing Documents with Acrobat Reader

You can print PDF files from within Acrobat Reader by choosing Print from the File menu. You can also print PDF files using Acrobat Reader from the command line. For example, to print the file sample.pdf to the default printer from the command line, enter:

```
# acroread --print sample.pdf
```

To print the file sample.pdf to the printer named laserprinter, enter:

```
# acroread --print sample.pdf --Plaserprinter
```

You can pipe a PDF file into acroread for printing using the --print option:

```
# cat sample.pdf | acroread --print
```

Converting PDF Files to PostScript Files with Acrobat Reader

You can convert PDF files to PostScript documents from the command line with Acrobat Reader. The following command converts the PDF file sample.pdf to a PostScript file stored as sample.ps:

```
# acroread --toPostScript sample.pdf
```

You can convert one or more PDF files and put the PostScript results into a directory. For example, to convert sample.1.pdf and sample.2.pdf (in the current directory) into PostScript files stored in the subdirectory samples_PS_dir, enter the following command:

```
# acroread --toPostScript sample.1.pdf sample.2.pdf samples_PS_dir
```

To specify a series of PDF files to be converted and specify an individual name for each converted PostScript file, use the --pairs option:

```
# acroread --toPostScript --pairs file_1.pdf file_1.ps ...
```
Using Display PostScript NX with Other Applications

The applications bundled with XpressWare are capable of automatically launching a Display PostScript NX agent if one is not available. However, some third-party Display PostScript applications, such as Sun AnswerBook, do not have this capability. Users can start an agent manually for use by these third-party applications with the following command:

```
# execnx &
```

Users only need to run `execnx` once per login session; the agent that it starts will be shared by all Display PostScript programs and applications that use the X display. See TekXpress Installation, Appendix A for information about Display PostScript agents.

Users can use the `listnx` utility to see if there are any agents already servicing their X displays:

```
# listnx
```

For details, see the `execnx` and `listnx` man pages located in `/tekxp/man/catn` by default.

Location of Documentation

PostScript language documents are installed in the `/tekxp/doc` directory by default. The documents themselves come from the directory `/tekxp/dpsnx_2.1/common/doc` and include:

- ShowPSUserGuide.ps
- ShowPSReferenceCard.ps

Adobe Acrobat Reader PDF documentation is located in `/tekxp/AcroRead_2.1/Help` and include:

- Help.pdf
- Tour.pdf

The man pages are installed in the `/tekxp/man/catn` directory.

Sample documents and example applications are located in `/tekxp/AcroRead_2.1/Help` and include:

- AcrBroch.pdf
- Backgrdr.pdf
- FeatBene.pdf
- SFO.pdf
- FoneAndMap.pdf
- ShowPSUserGuide.pdf
- ShowPSReferenceCard.pdf
- AeFables.pdf
- Claim.pdf
- ncaa1.pdf
Font Caching

The font caching feature stores fonts in memory for later use. This eliminates the need to download a font each time the application using the font is executed. For example, if you open and close your word processor, then open it again, the fonts are still available if your network computer’s memory. This is a more efficient use of resources, since fonts are cached once, instead of duplicated for each occurrence or downloaded over a busy network.

You can specify the amount of memory to allocate or you can flush cached fonts at any time. It is recommended that cache be flushed whenever new fonts (with a font path change) are added, to insure that the proper paths are cached. Flushing does not affect the current applications.

To set a Font Cache Limit:

1. Select Setup from the Client Launcher.
2. Check the amount of memory in your network computer by, dragging on Statistics and releasing on Memory.
3. Drag on Configuration Summaries and release on X Environment.
4. Set Font Cache Limit to the amount of memory in kilobytes to allow for font caching. Do not exceed the total memory for your network computer.

To empty the Font Cache and free up network computer memory:

1. Select Setup from the Client Launcher.
2. Drag on Configuration Summaries Menu and release on X Environment.
3. Click the Empty Font Cache button.
Printing Color Hardcopies

This section explains how to print a hardcopy by using the MWM pop-up menu item or by entering a command on the command line. Information in this section is specific to MWM. If you are using another window manager, refer to the documentation you received with that window manager for more information about printing a hardcopy.

NOTE: The host computer must have the appropriate software installed before you can use these hardcopy commands. If you cannot print a hardcopy, contact your system administrator.

Printing from MWM

You can use a pop-up menu to make a hardcopy of a window or a hardcopy of the entire screen.

Making a Hardcopy of a Window

1. Move the pointer outside of all windows and drag the Custom mouse button to display the pull-down menu.
2. Release on Hardcopy to display another pull-down menu.
3. Click the Custom mouse button on Window to change the pointer shape into a cross.
4. Move the pointer into the window you want to copy.
5. Click the Select mouse button. A single beep indicates the window is being copied. A double beep indicates the copying process is complete.

Making a Hardcopy of the Screen

1. Move the pointer outside of all windows and drag the custom mouse button to display the pull-down menu.
2. Release on Hardcopy to display another pull-down menu.
3. Click the custom mouse button on Screen. A single beep indicates the screen is being copied. A double beep indicates the copying process is complete.
Printing from the Command Line

Here is a general procedure for printing a hardcopy of a window:

1. Move the pointer into an X window and click the Select mouse button to activate the window.

2. Press the PrintScreen key. This key must be defined by your system administrator. Contact your administrator to find out which key to press and which printer your network computer is configured to use.
Flash Control Console

NOTE: The information in this section is written for system and network administrators responsible for installing and administering one or more network computers in a distributed-computing environment.

This section describes the Flash Control Console (FCC), a graphical user interface that allows the flashing of multiple network computers from a single, central terminal. The FCC offers a convenient alternative to flashing by use of configuration commands in the xp.cnf file. For more information about configuring flash memory by use of configuration commands, refer to Configuring Flash Memory on page 2-115 of the Network Computer Reference Manual.

Capabilities controlled by the FCC include:

• Handling a network of over 100 network computers.
• Interactively selecting terminals, network computer features, fonts and user files for flashing.
• Selecting fonts from multiple hosts.
• Supporting only TCP/IP.
• Displaying online status of a flash operation.
• Creating flash image of network computer features, fonts and user files selected for flashing.
• Flashing multiple network computers either on a file-by-file basis or from a created image.
• Simultaneous flashing of multiple network computers.
• Loading or saving settings from/to a user-specified file.
• Providing a log facility.
Before Using the FCC

- Make sure that the flash.rel file is in your config directory.
- Add flash_auth_xp to the xp.cnf file in the config directory for each terminal you want to flash.

Starting the FCC

To bring up the Main menu of the Flash Control Console, type:

```bash
> xpsh [-display displayname:0] fcc &
```

where displayname is the name of the display where the FCC will appear. If you do not enter displayname, the $DISPLAY environment variable is used as the default.

**NOTE:** You can also set displayname by changing the $DISPLAY environment variable.

![Flash Control Console Main Menu](image)

**Figure 4-21** The Flash Control Console Main Menu.
The Main menu of the FCC has four areas: The File Menu, the Menu Bar, the Menu Input Area and the Message Box. Let’s look at each of those areas in detail.

### The File Bar

The File Bar offers the following options on the File pull-down menu:

- **Load Settings** uses settings that have been previously saved (assumed not to be empty). Choosing this option brings up the Load New Configuration screen where you specify the access method, host and path of the configuration file you want to load.

- **Save Settings** uses the parameters selected on the FCC to update the settings file (see the following **NOTE**). Using this option brings up the Save Current Configuration screen where you specify the access, host and path where you want to store the configuration file.

  **NOTE:** You must create the Save Settings file before using the Save Settings option. To do this, type the following at the shell of the specified host:

  ```
  > touch <savesettings filename>
  ```

- **Log File** takes only the flash information that appears on the network computer console window and saves it in a file (see the following **NOTE**). Selecting Log File brings up the Set Logfile Attributes screen where you specify the access, host and path that is used to store the file.

  **NOTE:** You must create the Log File before using the Log File option. To do this, type the following at the shell of the specified host:

  ```
  > touch <log file filename>
  ```

- **Exit** ends the program.
Chapter 4 Using Advanced Features

The Menu Bar

The Menu Bar is where you select the activity you want to perform using FCC.

NOTE: These activities are not activated until after you click the Proceed for Flashing button (discussed shortly).

- Flash Settings flashes all the settings you select on the FCC.
- Flash Image uses a source image file to flash selected network computers.
- Create Image creates an image file using the current settings. If you select this activity, the Image Destination heading appears on the Main menu with the following choices:
  Access — TFTP, NFS or DAP (not currently supported).
  Host — The host name or address where you want to store the image file.
  Path — The name and full path of the image file. TFTP requires a publicly-writable file and NFS must have the file system mounted.
  Image Type — The network computer family used for image creation. Choices include: XP10, XP10T, XP330, XP330PEX and XP350.
- Query Image queries an image file.

The Menu Input Area

The area of the FCC where you select the options you want to flash is called the Menu Input Area and contains the following:

Access

Specifies which file access method to use. The options are: TFTP, NFS or DAP (not currently supported).

Host

The field you use to specify the host name or address where files to be flashed are read. For example: 128.123.186.67.

NOTE: The host name must be specified in the Internet Host Table of TekSetup.
Path
The text field you use to specify the source directory of the files you want to flash. For example, /vol/Boot.

Selection
Specifies the parameters available for flashing. The options are: Target network computers, Tek Features, User Files or User Fonts.

Compress
Selecting this option causes the files to be flashed in compressed format. It is recommended that you use Compress to save space; however, compression will affect system performance.

NOTE: This button does not appear if you select Flash Image or Query Image.

Available List
Lists the items that are currently available for flashing.

Selected List
Lists the items that have been selected for flashing.

NOTE: To move an individual item between the Available List and the Selected List, highlight the item you want to move and then click the appropriate “arrow” located between the lists.

Entry
A text field where you enter a parameter that can then be added to the Available List for flashing. This can include:

• A network computer address or name (if your network provides a name service).
• User file names.
• User fonts.
Chapter 4  Using Advanced Features

Add

Adds information to the Available List that currently appears in the Entry field.

NOTE: Items appearing in the Selected List also appear in the Available List enclosed in brackets.

Delete

Deletes highlighted names and addresses from the Available List.

NOTE: When you use this feature, the brackets around the items in the Available List (see “Add,” above) disappear.

Add all

Copies all the items from the Available List to the Selected List.

Del all

Deletes all the items in the Selected List.

Proceed for Flashing

Takes you to the Flash screen (discussed shortly).

The Message Box

The area at the bottom of the screen where a brief message displays whenever the cursor passes over a field on an FCC menu.
The Flash Screen

After selecting the features you want to flash and clicking the **Proceed for Flashing** button on the Main menu, the Flash screen appears (Figure 2).

![The Flash Screen](image)

The central part of the Flash screen is called the Overview. It is here that a list of the individual features you want flashed are listed, as well as current information about the status of any analysis being performed.

There are four buttons at the bottom of this menu:

- **Start**: This button starts the actual flashing.
- **Abort**: Stops the flash process.
- **Analyse**: Determines the available memory of the target network computer and compares that with the amount of memory required by the options to be flashed.
- **Return to Selection**: This button returns you to the Main menu of the *Flash Control Console*.
NOTE: If you do an analysis or flash and then click on the Return to Selection button, a warning box appears, letting you know that all flash information will be lost if you return to the Main menu.

After Doing an Analysis

Once you have completed an analysis, the Status line in the Overview area shows Analysis Complete. Double-clicking on a network computer name at this point brings up the Network Computer Status box, which displays the network computer name, status of the analysis, flash memory available, and total memory size required by the network computer. You can view the statistics for any groups listed by double-clicking on their name to bring up the Group Status box. Click on the Return to Netstation button and then the Return to Overview button to go back to the Flash Screen.
Chapter 5

Troubleshooting

Solving Power Problems

If you press the power button(s) and nothing happens:

• Check the back of the network computer and separate logic module (if you have one) to verify the power cord is firmly attached.

• Check the electrical outlet to make sure the power cord is firmly plugged in.

• Try a different electrical outlet, or try plugging something else into the outlet to verify the outlet has power.

If keyboard lights flash or if a bell sounds but nothing is displayed on the screen:

• On the network computer, check that the video cable is connected to the video port.

• On the monitor, check that the video cable is connected to the correct video inputs (video in).
Solving Boot Problems

If the network computer powers up, but the boot fails, there are various options to try. After each option, try to boot the network computer from the `BOOT>` prompt by typing `b` or `boot` and then pressing Enter.

- Verify the network computer keyboard, mouse and network cables are all firmly attached.

For advanced users who have access to the Tektronix NC200/NC400 Network Computer Reference manual, refer to the Boot Monitor chapter:

- Verify the boot method. It typically is TFTP or NFS for UNIX computers, MOP for DEC computers, or ROM if you have an optional Flash or ROM option.

- Verify host and gateway communications from the boot monitor with `ping`. If `ping` does not find the host, verify the host and network computer subnet masks are correctly set.

- If an error message says the boot file is not found:
  - Verify the expected information was obtained from the network
  - Verify the boot path is correct. It should contain both the path and the boot file name.
  - Verify that all the files have world read permissions

- If the configuration files are not found:
  - Verify the messages to verify which host is being polled for the files
  - Verify the primary and secondary paths are correctly set
  - Verify the paths and the read permissions on the files
Solving Log in Problems

If your network computer boots, but you are unable to log in:

• If the mouse or keyboard do not respond, check the cables and then reboot.

• If an error message is generated saying that the log in failed:
  - Retry entering your username and password
  - Verify you are connected to a host where you have a login account

• If a message is displayed saying that a connection timed out, restart the connection as detailed in Chapter 2, *Logging in to the Network Computer*.

• Check the Console window for error messages. Refer to *The Console Window* on page 5-4.
Chapter 5  Troubleshooting

The Console Window

The Console Window is a useful tool to see what is happening with the network computer. Messages, such as a confirmation that a file was located or that a command generated an error, are sent to this window. You must explicitly open and close the Console window through the Client Launcher.

Opening the Console Window

The Console window is a valuable tool to see messages being generated by the network computer. You can display this window at any time.

To open the Console window:

1. Select Console from the Client Launcher. If you need a refresher on the terminology used in these procedures, refer back to Chapter 1, Terminology.

The Console Window appears on your screen.

![Figure 5-1 Console Window.](image-url)
Using the Console Window

The network computer’s address and name (if defined) appear on the title bar. You cannot add or delete information from the Console. This window is updated whenever a confirmation or error message is received by the network computer.

Using the Console Window

Often there is more information available than will fit in the Console window. Since the Console window cannot be resized, use the methods listed below to view additional information. You can also copy and paste information from the Console to a command window.

- To display the previous screen of messages:
  Position the mouse pointer in the scroll bar anywhere above the slider box and click the Select (left) button.

- To display the next screen of messages:
  Position the mouse pointer in the scroll bar anywhere below the slider box and click the Select (left) button.

- To scroll through the messages one line at a time:
  Position the mouse pointer on the up or down arrow (on the scroll bar) and click the Select (left) button once for each line.

- To clear the contents of the Console window:
  Click on the Erase icon. The Console scrolls to just below the last line of information. Drag the slider box up to view the Console information.

- To copy information from the Console window and place it in the Console buffer:
  Position the mouse pointer on the first character to copy and click the Select (left) button. Drag the mouse to the last character to copy. The selected text is highlighted.

- To paste information from the Console buffer into a window:
  Position the mouse pointer in the window where you want to paste the information and click the Menu (middle) button. Information can be pasted in Telnet, Cterm, Lat, and xterm windows.
Chapter 5  Troubleshooting

Closing the Console Window

1. Select Console from the Client Launcher.

The Console Window disappears from your screen.
Special Keyboard Characters

This appendix describes how to work with special characters on different keyboards.

• *Entering North American Special Characters from International Keyboards* tells how to enable data processing keys so that you can use the North American character set on international keyboards.

• If you are using an LK401/VT200-style keyboard, refer to *Compose and Diacritical Sequences* for information on creating special characters and symbols by using compose characters.
Appendix A

Keyboard Charts

Figures A-1, A-2, A-3, A-4, A-5, A-6, A-7, and A-8 show examples of the standard types of keyboards available with the network computers. Refer to Appendix B, Keyboards in the Reference Manual for information about the key codes (which are the numbers that appear below the keys in the following figures).

![Keyboard Diagram]

Figure A-1 101 with Pause North American Keyboard.
Figure A-2 101 with Setup North American Keyboard.
Figure A-3  102 with Pause United Kingdom Keyboard.
Figure A-4 102 with Setup United Kingdom Keyboard.

Figure A-5 VT200/LK401-Style North American Keyboard.
Appendix A

Figure A-6 UNIX Keyboard.
Figure A-7 3270 Keyboard.

NOTE: For information about the 3270 keyboard, refer to the 3270/3179G User Manual.
Figure A-8 Sun V Keyboard.
Entering North American Special Characters from International Keyboards

Some data processing programs require entry of characters from the North American keyboard that are not available on all international keyboards. The characters needed but not always available are: `{ } [] \ @ # * $ |

To permit entry of the full North American character set from all keyboards, some international keyboards have one or more keys with dual legends on them. Legends on the left of LK401/VT200 keyboards are *typewriter* legends and legends on the right are *data processing* (DP) legends. (Legends on the right of 102-key keyboards are *alternate graphic* legends.)

You can enable DP legends for the LK401/VT200 keyboards from the Main Menu of *Setup*. The Main Menu displays a DP Mode item when you set Keyboard Type to VT200 and Language to one of the international languages. When you need these special symbols, enable the DP keys by clicking DP Mode to On. Click this item to Off when you need the usual national characters of the keyboard. If you want to run TekXpress compose, load the compose sequences. For details, refer to the *Compose and Diacritical Sequences* section later in the manual.

If TekXpress compose is enabled, you can also access DP legends from the keyboard (rather than through *Setup*) by using Compose sequences. To enter a DP legend, press the Compose key and then the desired key. So that you can enter all ASCII characters, several keyboards have compose sequences for DP keys that do not have DP legends on the keycaps. These compose sequences appear in the tables that follow. For more information about Compose sequences, refer to *Compose and Diacritical Sequences* later in this appendix.

When DP mode is off, the two-key sequences for accessing DP characters (Tables A-1 - A-9) supercede the three-key compose sequences involving the Compose-DP keys.
Tables A-1 through A-9 summarize the DP characters that are sent for each LK401/VT200-style international keyboard. These tables show both the Typewriter Mode and Data Processing Keys mode. As noted, some compose sequences do not have DP legends. Keyboards not appearing in these tables do not offer DP keys.

Table A-1 VT200/LK401 Danish Keyboard.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Key State</th>
<th>VT200</th>
<th>LK401</th>
<th>DP Keys</th>
<th>Compose-DP Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>VT200</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Typewriter</td>
<td>Normal</td>
<td>1</td>
<td>3 8 9</td>
<td>å ø 3</td>
<td></td>
</tr>
<tr>
<td>Shift</td>
<td></td>
<td>§</td>
<td>Å Ø</td>
<td></td>
<td>§ Å Ø</td>
</tr>
<tr>
<td>Data Processing</td>
<td>Normal</td>
<td>3</td>
<td>1  #</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keys</td>
<td>Shift</td>
<td>@</td>
<td>[ ]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LK401</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Typewriter</td>
<td>Normal</td>
<td>~</td>
<td>3 9</td>
<td>æ å ø</td>
<td></td>
</tr>
<tr>
<td>Shift</td>
<td></td>
<td>§</td>
<td>£ ¥</td>
<td></td>
<td>§ £ ¥</td>
</tr>
<tr>
<td>Data Processing</td>
<td>Normal</td>
<td>~</td>
<td>3 9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keys</td>
<td>Shift</td>
<td>@</td>
<td>#</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notes:
- VT200/lockout
- Compose sequence: § 3 9
## Table A-2 VT200/LK401 French Keyboard.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Key State</th>
<th>DP Keys</th>
<th>Compose-DP Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>VT200</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Typewriter</td>
<td>Normal</td>
<td>§ è ü</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>6 7 %</td>
<td></td>
</tr>
<tr>
<td>Data Processing</td>
<td>Normal</td>
<td>[ ] \</td>
<td></td>
</tr>
<tr>
<td>Keys</td>
<td>Shift</td>
<td>6 7 %</td>
<td></td>
</tr>
<tr>
<td><strong>LK401</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Typewriter</td>
<td>Normal</td>
<td>§ è ü 2</td>
<td>9 0</td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>6 7 %</td>
<td></td>
</tr>
<tr>
<td>Data Processing</td>
<td>Normal</td>
<td>[ ] \ é ç à</td>
<td></td>
</tr>
<tr>
<td>Keys</td>
<td>Shift</td>
<td>6 7 %</td>
<td></td>
</tr>
</tbody>
</table>

*Note: Table entries represent key combinations and their corresponding special characters.*
### Table A-3 VT200 German Keyboard.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Key State</th>
<th>DP Keys</th>
<th>Compose-DP Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>VT200 Typewriter</td>
<td>Normal</td>
<td>ü</td>
<td>ü</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ä</td>
<td>ä</td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>Ü</td>
<td>Ü</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ä</td>
<td>Ä</td>
</tr>
<tr>
<td></td>
<td></td>
<td>@</td>
<td>@</td>
</tr>
<tr>
<td></td>
<td></td>
<td>#</td>
<td>#</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(8)</td>
<td>(8)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9</td>
<td>9</td>
</tr>
</tbody>
</table>

### Table A-4 LK401 German Keyboard.

<table>
<thead>
<tr>
<th>Key Cap</th>
<th>Typewriter</th>
<th>Data Processing Keys</th>
<th>Compose-DP Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Normal</td>
<td>Normal</td>
<td>Normal</td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>Shift</td>
<td>Shift</td>
</tr>
<tr>
<td>,</td>
<td>#</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(</td>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>)</td>
<td>9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>°</td>
<td>^</td>
<td></td>
<td></td>
</tr>
<tr>
<td>^</td>
<td>~</td>
<td></td>
<td></td>
</tr>
<tr>
<td>!</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>!</td>
<td>!</td>
<td></td>
</tr>
<tr>
<td>&quot;</td>
<td>2</td>
<td>&quot;</td>
<td></td>
</tr>
<tr>
<td>§</td>
<td>$</td>
<td>$</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>$</td>
<td>$</td>
<td></td>
</tr>
</tbody>
</table>
### Entering North American Special Characters from International Keyboards

#### Table A-4 LK401 German Keyboard. (Continued)

<table>
<thead>
<tr>
<th>Key Cap</th>
<th>Typewriter</th>
<th>Data Processing Keys</th>
<th>Compose-DP Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Normal</td>
<td>Shift</td>
<td>Normal</td>
</tr>
<tr>
<td>$</td>
<td></td>
<td>π</td>
<td>1/4</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>1/4</td>
<td></td>
</tr>
<tr>
<td>%</td>
<td></td>
<td>%</td>
<td>1/2</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&amp;</td>
<td>6</td>
<td>&amp;</td>
<td>3/4</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>/</td>
<td>7</td>
<td>/</td>
<td>{</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(</td>
<td>8</td>
<td>(</td>
<td>[</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>)</td>
<td>9</td>
<td>)</td>
<td>]</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>=</td>
<td>O</td>
<td>=</td>
<td>}</td>
</tr>
<tr>
<td>o</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>?</td>
<td>β</td>
<td>?</td>
<td>\</td>
</tr>
<tr>
<td>β</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>`</td>
<td></td>
<td>`</td>
<td></td>
</tr>
<tr>
<td>`</td>
<td></td>
<td>`</td>
<td></td>
</tr>
<tr>
<td>Q</td>
<td>q</td>
<td>Q</td>
<td>@</td>
</tr>
<tr>
<td>@</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>R</td>
<td>r</td>
<td>R</td>
<td>¶</td>
</tr>
<tr>
<td>¶</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Z</td>
<td>z</td>
<td>Z</td>
<td>Z</td>
</tr>
<tr>
<td>¥</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>O</td>
<td>o</td>
<td>O</td>
<td>Ø</td>
</tr>
<tr>
<td>Ø</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table A-4 LK401 German Keyboard. (Continued)

<table>
<thead>
<tr>
<th>Key Cap</th>
<th>Typewriter</th>
<th>Data Processing Keys</th>
<th>Compose-DP Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Normal</td>
<td>Shift</td>
<td>Normal</td>
</tr>
<tr>
<td>P</td>
<td>p</td>
<td>P</td>
<td>p</td>
</tr>
<tr>
<td>Ü</td>
<td>ü</td>
<td>Ü</td>
<td>~</td>
</tr>
<tr>
<td>*</td>
<td>+</td>
<td>*</td>
<td>~</td>
</tr>
<tr>
<td>À</td>
<td>a</td>
<td>A</td>
<td>ã</td>
</tr>
<tr>
<td>S</td>
<td>s</td>
<td>S</td>
<td>ß</td>
</tr>
<tr>
<td>D</td>
<td>d</td>
<td>D</td>
<td>δ</td>
</tr>
<tr>
<td>F</td>
<td>f</td>
<td>F</td>
<td>f</td>
</tr>
<tr>
<td>;</td>
<td>;</td>
<td>;</td>
<td>;</td>
</tr>
<tr>
<td>K</td>
<td>k</td>
<td>K</td>
<td>k</td>
</tr>
<tr>
<td>Ö</td>
<td>ö</td>
<td>Ö</td>
<td>'</td>
</tr>
<tr>
<td>Ä</td>
<td>ä</td>
<td>Ä</td>
<td>^</td>
</tr>
<tr>
<td>¥</td>
<td>#</td>
<td>#</td>
<td>#</td>
</tr>
<tr>
<td>&gt;</td>
<td>&lt;</td>
<td>&gt;</td>
<td></td>
</tr>
</tbody>
</table>
### Entering North American Special Characters from International Keyboards

#### Table A-4 LK401 German Keyboard. (Continued)

<table>
<thead>
<tr>
<th>Key Cap</th>
<th>Typewriter</th>
<th>Data Processing Keys</th>
<th>Compose-DP Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Normal</td>
<td>Shift</td>
<td>Normal</td>
</tr>
<tr>
<td>Y &lt;</td>
<td>y</td>
<td>Y</td>
<td>&lt;&lt;</td>
</tr>
<tr>
<td>y &lt;&lt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>X &gt;</td>
<td>x</td>
<td>X</td>
<td>&gt;&gt;</td>
</tr>
<tr>
<td>x &gt;&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C ⌥</td>
<td>c</td>
<td>C</td>
<td>⌥</td>
</tr>
<tr>
<td>⏎</td>
<td>m</td>
<td>M</td>
<td>⌥</td>
</tr>
<tr>
<td>. ×</td>
<td>:</td>
<td>•</td>
<td>÷</td>
</tr>
</tbody>
</table>
Table A-5 VT200/LK401 Italian Keyboard.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Key State</th>
<th>VT200</th>
<th>DP Keys</th>
<th>Compose-DP Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>1 £ @ 2 é # 9 ç [ 0 à ] $ \ *</td>
<td>% ù = § $</td>
<td></td>
</tr>
<tr>
<td>VT200</td>
<td>Typewriter</td>
<td>Normal</td>
<td>£ é ç à *</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>1 2 9 0 §</td>
<td>[ ]</td>
<td>( )</td>
</tr>
<tr>
<td></td>
<td>Data</td>
<td>Normal</td>
<td>@ # [ ]  *</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Processing</td>
<td>Shift</td>
<td>1 2 9 0 \</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Keys</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LK401</td>
<td>Typewriter</td>
<td>Normal</td>
<td>£ é ç à *</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>1 2 9 0 §</td>
<td>%</td>
<td>= !</td>
</tr>
<tr>
<td></td>
<td>Data</td>
<td>Normal</td>
<td>@ # [ ]  *</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Processing</td>
<td>Shift</td>
<td>1 2 9 0 \</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Keys</td>
<td></td>
<td>%</td>
<td>= !</td>
</tr>
</tbody>
</table>
Table A-6 VT200/LK401 Norwegian Keyboard.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Key State</th>
<th>VT200</th>
<th>LK401</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>DP Keys</td>
<td>Compose-DP Keys</td>
</tr>
<tr>
<td></td>
<td></td>
<td>§ @ 3</td>
<td>§</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Å [ ]</td>
<td>Å</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Æ \ #</td>
<td>Æ</td>
</tr>
<tr>
<td></td>
<td></td>
<td>’ ( )</td>
<td>’ ( )</td>
</tr>
<tr>
<td>Typewriter</td>
<td>Normal</td>
<td>3 å æ</td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>§ Å Æ</td>
<td></td>
</tr>
<tr>
<td>Data Processing Keys</td>
<td>Normal</td>
<td>3</td>
<td>]</td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>@</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>}</td>
<td>{</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ø</td>
<td></td>
</tr>
</tbody>
</table>

Network Computer User  A-17
**Table A-7 VT200/LK401 Spanish Keyboard.**

<table>
<thead>
<tr>
<th>Mode</th>
<th>Key State</th>
<th>DP Keys</th>
<th>Compose-DPKeys</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>VT200</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Typewriter</td>
<td>Normal</td>
<td>ñ</td>
<td>ñ</td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>ñ</td>
<td></td>
</tr>
<tr>
<td>Data Processing Keys</td>
<td>Normal</td>
<td>ñ</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>ñ</td>
<td></td>
</tr>
<tr>
<td><strong>LK401</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Typewriter</td>
<td>Normal</td>
<td>ñ</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>ñ</td>
<td></td>
</tr>
<tr>
<td>Data Processing Keys</td>
<td>Normal</td>
<td>ñ</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>ñ</td>
<td></td>
</tr>
</tbody>
</table>
## Table A-8 VT200/LK401 Swedish/Finnish Keyboard.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Key State</th>
<th>VT200</th>
<th>LK401</th>
<th>DP Keys</th>
<th>Compose-DP Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Typewriter</strong></td>
<td>Normal</td>
<td>$3$ 4</td>
<td>$3$ 4</td>
<td>å ü</td>
<td>{}</td>
</tr>
<tr>
<td></td>
<td>Shft</td>
<td>$\S$ $|$</td>
<td>$\S$ $|$</td>
<td>Å Ü</td>
<td></td>
</tr>
<tr>
<td><strong>Data Processing Keys</strong></td>
<td>Normal</td>
<td>$3$ 4</td>
<td>$3$ 4</td>
<td>] #</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shft</td>
<td>$\S$ $|$</td>
<td>$\S$ $|$</td>
<td>[ \</td>
<td></td>
</tr>
<tr>
<td><strong>Typewriter</strong></td>
<td>Normal</td>
<td>$3$ 4</td>
<td>$3$ 4</td>
<td>å ü Ö ä</td>
<td>{}</td>
</tr>
<tr>
<td></td>
<td>Shft</td>
<td>$\S$ $|$</td>
<td>$\S$ $|$</td>
<td>Å Ü ö Å</td>
<td></td>
</tr>
<tr>
<td><strong>Data Processing Keys</strong></td>
<td>Normal</td>
<td>$3$ 4</td>
<td>$3$ 4</td>
<td>] #</td>
<td>ä</td>
</tr>
<tr>
<td></td>
<td>Shft</td>
<td>$\S$ $|$</td>
<td>$\S$ $|$</td>
<td>[ \</td>
<td></td>
</tr>
</tbody>
</table>
### Table A-9 VT200/LK401 Swiss/German Keyboard.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Key State</th>
<th>DP Keys</th>
<th>Compose-DP Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>VT200</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Typewriter</strong></td>
<td>Normal</td>
<td>4 ü ö ä $</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>ç è é à £</td>
<td></td>
</tr>
<tr>
<td>Data Processing Keys</td>
<td>Normal</td>
<td>4 ü ö ä $</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>@ \ [ ]</td>
<td></td>
</tr>
<tr>
<td>LK401</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Typewriter</strong></td>
<td>Normal</td>
<td>4 ü ö ä $</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>ç è é à £</td>
<td></td>
</tr>
<tr>
<td>Data Processing Keys</td>
<td>Normal</td>
<td>4</td>
<td>{ } $</td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>@ \ [ ] #</td>
<td></td>
</tr>
</tbody>
</table>

### Table A-10 VT200/LK401 United Kingdom Keyboard.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Key State</th>
<th>DP Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>VT200</td>
<td></td>
<td>£ # 3</td>
</tr>
<tr>
<td><strong>Typewriter</strong></td>
<td>Normal</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>£</td>
</tr>
<tr>
<td>Data Processing Keys</td>
<td>Normal</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>#</td>
</tr>
</tbody>
</table>
Compose and Diacritical Sequences

On LK401/VT200-style keyboards you can use compose characters to type special characters and symbols that are not available as single keystrokes. These might be common characters, such as the cent sign (¢), or letter forms particular to a certain language, for example, a lowercase “e” with an acute accent.

Network computers directly support compose characters for all X11 clients with LK401/VT200 keyboards, other than North American. DEC VMS and ULTRIX X applications provide their own compose characters. Refer to your DECWindows documentation for information about DEC compose characters.

To use DEC compose characters:

1. Select Setup from the Client Launcher. Select either VT200/LK401 ULTRIX (ESC) or VT200/LK401 VMS (F11) as the Keyboard Type.
2. Set the Compose Sequences option to No.
3. Use a DEC VMS or ULTRIX X application.
4. Begin a compose sequence by pressing the Compose key.
Appendix A

To use TekXpress compose characters:

1. Select Setup from the Client Launcher.
2. Select VT200/LK401 X (ESC-BS-LF) or VT200/LK401 X (F11-F13) as the Keyboard Type.
3. Set the Compose Sequences option to Yes.
4. Select a Keyboard Nationality. (To use North American, use xmodmap to clear the modifier by entering the following: `xmodmap -e "clear mod1"`)

You can compose TekXpress compose characters in two ways:

- Press a diacritical key (described under Using the Diacritical Keys later in this appendix), and then the character to be combined with it (valid combinations are shown in Table A-11).

- Press the Compose key (described under Using the Compose Key later in this appendix), and then type the two composing characters (valid combinations are shown in Table A-12).

NOTE: To enter a special character, your application must support 8-bit characters and select fonts. If you cannot enter special characters, contact your system administrator.
Using the Diacritical Keys

There are from one to five diacritical keys on all international VT200-style keyboards (except North American). These keys do not send characters when you press them; rather, they combine with the next character you type to form a special symbol.

For example, on keyboards for which tilde (~) is a diacritical mark, you compose the ñ Spanish character by pressing the "~" key and then pressing the "n" key.

To cancel a diacritical key sequence:
• Press the Delete key, or
• Press another diacritical key (if you want to start a new sequence).

If you type an invalid sequence: the entry is ignored, the bell on the network computer rings, and the diacritical sequence terminates.

The Compose light turns OFF when you complete the compose sequence.

The acute accent (´) character is a special case: on the keyboard, it shares its visual representation with the apostrophe ('). Depending on the keyboard nationality, the keyboard character on the network computer represents an acute accent (a diacritical mark) or an apostrophe (a character).

Table A-11 shows the diacritical keys available on various keyboards.

Table A-11 Diacritical Keys.

<table>
<thead>
<tr>
<th>Keyboard</th>
<th>Diacritical Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Danish/Norwegiana</td>
<td>~</td>
</tr>
<tr>
<td>French</td>
<td>~</td>
</tr>
<tr>
<td>Germana</td>
<td>~</td>
</tr>
<tr>
<td>Italian</td>
<td>~</td>
</tr>
<tr>
<td>North American</td>
<td>none</td>
</tr>
<tr>
<td>Spanishb</td>
<td>~</td>
</tr>
<tr>
<td>Swedish</td>
<td>~</td>
</tr>
</tbody>
</table>
Appendix A

Table A-11 Diacritical Keys.

<table>
<thead>
<tr>
<th>Keyboard</th>
<th>Diacritical Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Swiss-German</td>
<td><code> </code> <code> </code></td>
</tr>
<tr>
<td>United Kingdom</td>
<td><code> </code> <code> </code></td>
</tr>
</tbody>
</table>

a Two single-quote symbols appear on the keyboard. The one on the top row of keys is a diacritical mark and can be thought of as an acute accent (‘). The other one is not a diacritical mark and can be thought of as an apostrophe (’).

b Two single-quote symbols appear on the keyboard. The one on the top row of keys is not a diacritical mark and can be thought of as an apostrophe (’). The other one, next to the ñ key, is the diacritical mark.
Variations from DEC Compose Sequences

The following differences exist between the Tektronix network computer and the DEC VT200 compose sequences:

- The sequence that generates a double quote on the VT200 generates an umlaut on the Tektronix network computer.

- There is no difference on the VT200 between an apostrophe and an acute accent. Depending on keyboard nationality, you can treat the acute accent on the keyboard as a diacritical mark (an acute accent). You can access the apostrophe symbol on the keyboard through a compose sequence.

- The Tektronix network computer provide compose sequences for dollar sign, small and capital Icelandic eth, small and capital Icelandic thorn, small and capital y with an acute accent, three-fourths fraction, division sign, multiplication sign, acute accent, umlaut, overbar, cedilla, registered sign, broken vertical bar, not sign, no-break space, and soft hyphen.

- You access TekXpress and DEC three-key compose characters by pressing Compose, rather than holding the Compose key and pressing the spacebar as described for DEC workstations.

- DEC compose sequences do not have the "Compose-DP" sequence.
Using the Compose Key

The Compose key starts a three-key compose sequence for all LK401/VT200-style international keyboards (except North American). For example, to compose a cent sign, press the Compose key followed by the "c" and "|" keys. When you press the Compose key, the Compose light turns ON to indicate that you are composing a special character.

To cancel a compose sequence:

• Press the Delete key, or

• Press the Compose key (if you want to start a new sequence).

If you type an invalid sequence: the entry is ignored, the bell on the network computer rings, and the compose sequence terminates.

The Compose light turns OFF when you complete the compose sequence.

Compose Sequences

Table A-12 lists all the compose characters and the two- or three-key sequences used to form the characters. You can enter the last two keys of three-key sequences in any order. The notes in the table refer to:

a To compose a character with a three-key sequence, press Compose Character followed by the two keys shown in this column.

b Two-key compose sequences are only available on national keyboards that support the requisite diacritical marks.

c You can use either two apostrophes (‘ ‘ – available on all keyboards) or two acute accents (´ ´ – available only on the German, Danish/Norwegian, and Spanish keyboards) to compose an acute accent.

Table A-12 Compose Sequences for VT200-Style Keyboards.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Compose Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>[</td>
<td>Left bracket</td>
<td>Three-Key³</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Two-Key³</td>
</tr>
<tr>
<td></td>
<td></td>
<td>( (</td>
</tr>
</tbody>
</table>
Using the Compose Key

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Compose Sequence</th>
<th>Three-Key&lt;sup&gt;a&lt;/sup&gt;</th>
<th>Two-Key&lt;sup&gt;b&lt;/sup&gt;</th>
</tr>
</thead>
</table>
| \
| Backslash     | //                | / <                |                       |
| ]            | Right bracket     | ) )              |                        |
| [            | Left brace        | ( -               |                        |
| | Vertical bar   | ^ /             | ^ /               |                        |
| )            | Right brace       | ) -              |                        |
| #            | Pound sign        | + +              |                        |
| ^            | Circumflex        | ^ Sp             | ^ Sp                  |
|             |                   | ^ ^             | ^ ^                  |
| ~            | Tilde             | ~ Sp             | ~ Sp                  |
| @            | Commercial At sign| A A              | a a                   |
| $            | Dollar sign       | S /              | s /                   |
|             |                   | s /              | S |                    |
|             |                   | s |                |                       |
| á            | Apostrophe        | ' Sp             | ' Sp                  |
|             |                   | ' Sp             | ' Sp                  |
| á            | Small a with acute accent | ' a | ' a |
| Á            | Capital A with acute accent | ' A | ' A |
### Table A-12 Compose Sequences for VT200-Style Keyboards. (Continued)

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Compose Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>à</td>
<td>Small a with grave accent</td>
<td><code>a,</code> a</td>
</tr>
<tr>
<td>À</td>
<td>Capital A with grave accent</td>
<td><code>A,</code> A</td>
</tr>
<tr>
<td>â</td>
<td>Small a with circumflex</td>
<td>^ a, ^ a</td>
</tr>
<tr>
<td>Â</td>
<td>Capital A with circumflex</td>
<td>^ A, ^ A</td>
</tr>
<tr>
<td>ä</td>
<td>Small a with umlaut</td>
<td>a &quot;</td>
</tr>
<tr>
<td>Ä</td>
<td>Capital A with umlaut</td>
<td>A &quot;</td>
</tr>
<tr>
<td>ã</td>
<td>Small a with tilde</td>
<td>~ a, ~ a</td>
</tr>
<tr>
<td>Æ</td>
<td>Capital A with tilde</td>
<td>~ A, ~ A</td>
</tr>
<tr>
<td>å</td>
<td>Small a with ring</td>
<td>a *</td>
</tr>
<tr>
<td>Å</td>
<td>Capital A with ring</td>
<td>A *</td>
</tr>
<tr>
<td>æ</td>
<td>Small ae ligature</td>
<td>a e</td>
</tr>
<tr>
<td>Æ</td>
<td>Capital AE ligature</td>
<td>A E</td>
</tr>
<tr>
<td>ç</td>
<td>Small c with cedilla</td>
<td>c ,</td>
</tr>
<tr>
<td>Ç</td>
<td>Capital C with cedilla</td>
<td>C ,</td>
</tr>
<tr>
<td>D</td>
<td>Capital Icelandic Eth</td>
<td>D -</td>
</tr>
<tr>
<td>ð</td>
<td>Small Icelandic eth</td>
<td>d -</td>
</tr>
<tr>
<td>é</td>
<td>Small e with acute accent</td>
<td>´ e, ´ e</td>
</tr>
<tr>
<td>É</td>
<td>Capital E with acute accent</td>
<td>´ E, ´ E</td>
</tr>
</tbody>
</table>
Using the Compose Key

Table A-12 Compose Sequences for VT200-Style Keyboards. (Continued)

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Compose Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>è</td>
<td>Small e with grave accent</td>
<td>` e</td>
</tr>
<tr>
<td>Ê</td>
<td>Capital E with grave accent</td>
<td>` E</td>
</tr>
<tr>
<td>ê</td>
<td>Small e with circumflex</td>
<td>^ e</td>
</tr>
<tr>
<td>Ê</td>
<td>Capital E with circumflex</td>
<td>^ E</td>
</tr>
<tr>
<td>í</td>
<td>Small i with acute accent</td>
<td>´ i</td>
</tr>
<tr>
<td>Í</td>
<td>Capital I with acute accent</td>
<td>´ I</td>
</tr>
<tr>
<td>ï</td>
<td>Small i with grave accent</td>
<td>` i</td>
</tr>
<tr>
<td>Í</td>
<td>Capital I with grave accent</td>
<td>` I</td>
</tr>
<tr>
<td>ì</td>
<td>Small i with circumflex</td>
<td>^ i</td>
</tr>
<tr>
<td>Ì</td>
<td>Capital I with circumflex</td>
<td>^ I</td>
</tr>
<tr>
<td>ü</td>
<td>Small i with diaeresis</td>
<td>&quot; i</td>
</tr>
<tr>
<td>Ì</td>
<td>Capital I with diaeresis</td>
<td>&quot; I</td>
</tr>
<tr>
<td>ñ</td>
<td>Small n with tilde</td>
<td>~ n</td>
</tr>
<tr>
<td>Ñ</td>
<td>Capital N with tilde</td>
<td>~ N</td>
</tr>
<tr>
<td>ô</td>
<td>Small o with acute accent</td>
<td>` o</td>
</tr>
<tr>
<td>Ô</td>
<td>Capital O with acute accent</td>
<td>` O</td>
</tr>
<tr>
<td>ò</td>
<td>Small o with grave accent</td>
<td>` o</td>
</tr>
<tr>
<td>Ô</td>
<td>Capital O with grave accent</td>
<td>` O</td>
</tr>
<tr>
<td>ò</td>
<td>Small o with circumflex</td>
<td>^ o</td>
</tr>
<tr>
<td>Ô</td>
<td>Capital O with circumflex</td>
<td>^ O</td>
</tr>
</tbody>
</table>
## Table A-12 Compose Sequences for VT200-Style Keyboards. (Continued)

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Compose Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Three-Key&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>ö</td>
<td>Small o with umlaut</td>
<td>o &quot;</td>
</tr>
<tr>
<td>Ö</td>
<td>Capital O with umlaut</td>
<td>O &quot;</td>
</tr>
<tr>
<td>ò</td>
<td>Small o with tilde</td>
<td>~ o</td>
</tr>
<tr>
<td>Ò</td>
<td>Capital O with tilde</td>
<td>~ O</td>
</tr>
<tr>
<td>ø</td>
<td>Small o with slash</td>
<td>o /</td>
</tr>
<tr>
<td>Ø</td>
<td>Capital O with slash</td>
<td>O /</td>
</tr>
<tr>
<td>ß</td>
<td>Small German sharp s</td>
<td>s s</td>
</tr>
<tr>
<td>p</td>
<td>Small Icelandic thorn</td>
<td>p p</td>
</tr>
<tr>
<td>P</td>
<td>Capital Icelandic Thorn</td>
<td>P P</td>
</tr>
<tr>
<td>ú</td>
<td>Small u with acute accent</td>
<td>´ u</td>
</tr>
<tr>
<td>Ú</td>
<td>Capital U with acute accent</td>
<td>´ U</td>
</tr>
<tr>
<td>ù</td>
<td>Small u with grave accent</td>
<td>` u</td>
</tr>
<tr>
<td>Ù</td>
<td>Capital U with grave accent</td>
<td>` U</td>
</tr>
<tr>
<td>ù</td>
<td>Small u with circumflex</td>
<td>^ u</td>
</tr>
<tr>
<td>Ù</td>
<td>Capital U with circumflex</td>
<td>^ U</td>
</tr>
<tr>
<td>ü</td>
<td>Small u with umlaut</td>
<td>u &quot;</td>
</tr>
<tr>
<td>Õ</td>
<td>Capital U with umlaut</td>
<td>U &quot;</td>
</tr>
<tr>
<td>‘y</td>
<td>Small y with acute accent</td>
<td>‘ y</td>
</tr>
</tbody>
</table>
Using the Compose Key

Table A-12 Compose Sequences for VT200-Style Keyboards. (Continued)

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Compose Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>′Y</td>
<td>Capital Y with acute accent</td>
<td>′ Y ′ Y</td>
</tr>
<tr>
<td>ˇy</td>
<td>Small y with diaeresis</td>
<td>ˇ y ˇ y</td>
</tr>
<tr>
<td></td>
<td>No-break space</td>
<td>$p \ $p</td>
</tr>
<tr>
<td>1/4</td>
<td>Fraction one-fourth</td>
<td>1 4</td>
</tr>
<tr>
<td>1/2</td>
<td>Fraction one-half</td>
<td>1 2</td>
</tr>
<tr>
<td>3/4</td>
<td>Fraction three-fourths</td>
<td>3 4</td>
</tr>
<tr>
<td>1</td>
<td>Superscript 1</td>
<td>^ 1</td>
</tr>
<tr>
<td>2</td>
<td>Superscript 2</td>
<td>^ 2</td>
</tr>
<tr>
<td>3</td>
<td>Superscript 3</td>
<td>^ 3</td>
</tr>
<tr>
<td></td>
<td>Plus-or-minus sign</td>
<td>± ±</td>
</tr>
<tr>
<td>÷</td>
<td>Division sign</td>
<td>- :</td>
</tr>
<tr>
<td>×</td>
<td>Multiplication sign</td>
<td>X X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>x x</td>
</tr>
<tr>
<td>₣</td>
<td>Currency sign</td>
<td>X 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X O</td>
</tr>
<tr>
<td></td>
<td></td>
<td>x 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>x o</td>
</tr>
<tr>
<td>£</td>
<td>Pounds currency sign</td>
<td>L -</td>
</tr>
<tr>
<td></td>
<td></td>
<td>L =</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 -</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 =</td>
</tr>
</tbody>
</table>
### Table A-12 Compose Sequences for VT200-Style Keyboards. (Continued)

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Compose Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Three-Key</td>
</tr>
<tr>
<td>€</td>
<td>Cent sign</td>
<td>C /</td>
</tr>
<tr>
<td></td>
<td></td>
<td>C</td>
</tr>
<tr>
<td></td>
<td></td>
<td>c /</td>
</tr>
<tr>
<td></td>
<td></td>
<td>c</td>
</tr>
<tr>
<td>¥</td>
<td>Yen sign</td>
<td>Y -</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Y =</td>
</tr>
<tr>
<td></td>
<td></td>
<td>y -</td>
</tr>
<tr>
<td></td>
<td></td>
<td>y =</td>
</tr>
<tr>
<td>'</td>
<td>Acute accent</td>
<td><code> </code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code> </code></td>
</tr>
<tr>
<td>`</td>
<td>Grave accent</td>
<td>` sp</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code> </code></td>
</tr>
<tr>
<td>``</td>
<td>Diaeresis or umlaut</td>
<td>` sp</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code> </code></td>
</tr>
<tr>
<td>—</td>
<td>Macron or overbar</td>
<td>— —</td>
</tr>
<tr>
<td>,</td>
<td>Cedilla</td>
<td><code> </code></td>
</tr>
<tr>
<td>-</td>
<td>Soft hyphen</td>
<td>— —</td>
</tr>
<tr>
<td>µ</td>
<td>Small mu or micro sign</td>
<td>/ U</td>
</tr>
<tr>
<td></td>
<td></td>
<td>/ u</td>
</tr>
</tbody>
</table>
Table A-12 Compose Sequences for VT200-Style Keyboards. (Continued)

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Compose Sequence</th>
<th>Three-Key⁹</th>
<th>Two-Key¹⁰</th>
</tr>
</thead>
<tbody>
<tr>
<td>°</td>
<td>Degree sign</td>
<td></td>
<td>^ 0</td>
<td>^ 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>°</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_p °</td>
<td></td>
<td></td>
</tr>
<tr>
<td>°</td>
<td>Masculine ordinal indicator</td>
<td>O _</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o _</td>
<td></td>
<td></td>
</tr>
<tr>
<td>*</td>
<td>Feminine ordinal indicator</td>
<td>A _</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>a _</td>
<td></td>
<td></td>
</tr>
<tr>
<td>§</td>
<td>Section sign</td>
<td>S 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>s 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>S O</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>s o</td>
<td></td>
<td></td>
</tr>
<tr>
<td>¶</td>
<td>Paragraph or pilcrow</td>
<td>P !</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p !</td>
<td></td>
<td></td>
</tr>
<tr>
<td>⋅</td>
<td>Centered dot</td>
<td>^ .</td>
<td></td>
<td>^ .</td>
</tr>
<tr>
<td>©</td>
<td>Copyright sign</td>
<td>C 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>c 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>C O</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>c O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>®</td>
<td>Registered sign</td>
<td>R 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>r 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>R O</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>r o</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table A-12 Compose Sequences for VT200-Style Keyboards. (Continued)

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Compose Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>¡</td>
<td>Inverted exclamation mark</td>
<td>¡ !</td>
</tr>
<tr>
<td>¿</td>
<td>Inverted question mark</td>
<td>? ?</td>
</tr>
<tr>
<td>«</td>
<td>Angle quotation mark left</td>
<td>&lt; &lt;</td>
</tr>
<tr>
<td>»</td>
<td>Angle quotation mark right</td>
<td>&gt; &gt;</td>
</tr>
<tr>
<td></td>
<td>Broken vertical bar</td>
<td>! =</td>
</tr>
<tr>
<td>¬</td>
<td>Not sign</td>
<td>- !</td>
</tr>
</tbody>
</table>
Glossary

Active Window
The window where the input (focus) is directed.

Application Program
Programs such as word processors, transaction processors, and computer-aided drafting, that you run on your network computer. Also known as client. See Client.

Button (on the display)
A small display box that has a raised appearance and contains text. Generally, clicking on a button activates a function or performs some action. See Clicking.

Button (on the mouse)
The three buttons on the top of the mouse. See Select, Menu, and Custom.

Clicking
Quickly pressing and releasing the Select mouse button without moving the pointer.

Client
An application program that connects to the server. A client program performs a variety of tasks, including window management.

Chroma
A term that describes the saturation or vividness of a color. A chroma of 0 describes a neutral, gray color. Chroma ranges to the most vivid color a screen or printer generates for a specific hue and value. See Hue and Value.

Colormap
Consists of a set of entries defining color values. A pixel value indexes into the colormap thereby producing intensities of red, green, and blue which are visible on a display.
**Glossary**

**Command Line**
The line that you type to invoke a program or initiate an action. A command line usually contains the name of an X client or application program, along with optional arguments known as command-line options.

**Cterm**
A user-level protocol which is part of the DECnet Protocol set. Cterm provides a Network Virtual Terminal, which allows you to log in to a remote host on the network as if you are using a terminal directly attached to the remote host.

**Custom (mouse button)**
The factory default defines this as the right mouse button.

**Cursor**
The visible shape of a pointer on the screen. Defining a cursor for a window controls the visible appearance when the pointer is in that window. See Pointer.

**DAP**
See Data Access Protocol.

**Data Access Protocol (DAP)**
A protocol that provides read and write support for font files, the color definition file, or remote configuration files.

**Dialog Box**
A box where you choose options and enter information. Use the mouse to move from field to field, click on buttons and position the text cursor. Enter information with the keyboard.

**Display**
A device that receives video output from the logic module and displays the video output on a screen.

**Dragging**
Pressing and holding down the Select mouse button while moving the pointer.
Glossary

**Ethernet**

An IEEE standard protocol used within various networks, including TCP/IP.

**Ethernet Address**

The factory-defined hardware address of the network computer. Network hardware uses the Ethernet address when communicating to the network. This address is on the serial number label on the back of the logic module. You can also display the Ethernet address by viewing the TCP/IP Configuration Summary Menu in *Setup*.

**Event**

In the X Window System, information sent by the X server to an X client — for example, notification to the client that you pressed a mouse button.

**Factory Default**

The value assigned to a parameter as delivered from the factory.

**Firmware**

Software instructions that are permanently stored in the memory of a computer and are not lost when you turn the power off. Also called NVRAM.

**Hardcopy**

A physical copy (typically printed on paper) of a file.

**Hardware**

The physical parts of a computing device, such as a network computer.

**Host Computer**

A computer device that controls the exchange of data between itself and another network computer. Network computers typically boot from a host.

**HostMenu**

A window showing a list of host computer names and network addresses. Use the mouse to select a computer where you have a login account.
Hue
A term that describes a color family (for example, red or yellow). Hue is a polar coordinate — that is, it moves in a circular motion around the color spectrum — and ranges from $0^\circ$ to $360^\circ$, with $0^\circ$ being red. Hue is measured in degrees. See Chroma and Value.

Index Area
A box on the screen that lets you enter a color index — an integer used to label a particular color — from the keyboard.

Input Device
A device that allows you to send information to a window. Typical input devices include keyboards, mice, tablets, and trackballs. See Pointer and Pointing Device.

Interface
A common connection that is used for sending or accepting information and control between programs and machines.

Internet Address (IP Address)
A system administrator-assigned address for the network computer. This address is used under TCP/IP when the network software of the network computer generates messages to another host. The IP address is in the form $n.nn.n.nn.n.nn$ where $n.nn$ is a decimal number in the range 0 to 255. You can display the IP address by viewing the Network Configuration Summary Menu in Setup.

Internet Protocol (IP)
The network layer protocol for the Internet Protocol Suite. Internet Protocol is responsible for addressing and routing packets between hosts.

Keyboard
An input device that allows you to communicate with your client program.

LAN
See Local Area Network.
**LAT**

*See* Local Area Transport

**Local Area Network (LAN)**

The linking together of terminals, network computers, and computers via cables and microwave links. This allows you to access more than one computer.

**Local Area Transport (LAT)**

A client which provides a connection to a host computer that supports LAT.

**Local Clients**

Programs running on the same host as the server.

**Logic Module**

A device that gets data from a host, a keyboard, or a peripheral, and processes it for viewing on the display. The logic module runs the X server and local clients. It can be a separate unit, or integrated into the base of the monitor.

**Memory**

A part of a network computer that stores data.

**Menu**

A list of commands or functions that you select with a pointer. A menu is normally displayed in a small window.

**Menu (mouse button)**

The factory default defines this as the middle mouse button.

**Move**

Change the location of the pointer on the screen by moving the mouse.

**Mouse**

An input device that, when moved across a flat surface, causes the pointer to move across a screen. The mouse usually has buttons that you press to send signals. These signals, in turn, accomplish certain functions. The representation of the *mouse* on the screen is called the pointer. *See* Pointer.
Network
The physical wires connecting two or more computers. These connections allow information to move electronically between computers.

Network Computer
A computer that displays information which usually resides on another computer. A network computer consists of a display, a keyboard, a mouse or other pointing device, a logic module, an X server, and local clients. See Display, Logic Module, Mouse, Pointer, and X Server.

Parameter
A variable that is given a specific value. This value is passed to a program before execution.

Peripheral Device
A device used to input or output data for the network computer. The XPT/A graphics tablet is a supported peripheral device for network computers.

Pixel
The smallest part of a screen surface that can be addressed.

Pointer
The pointer allows you to make selections in menus, to size and position windows and icons, and to select the window where you want to send the input. The window manager determines the shape of the pointer. See Pointing Device.

Pointing Device
Typically a mouse, tablet, or some other device with effective dimensional motion. The core protocol defines only one visible cursor, which tracks whatever pointing device is attached as the pointer. See Pointer.

Port
A physical connection (such as a multi-pin connector or coaxial connector) and its associated firmware, that permits one computing device to communicate data and control information with another computing device or peripheral device.
Glossary

**Protocol**
A set of rules that allows computers to transfer information across a network to other computers that speak different computer languages.

**Read-Only Memory (ROM)**
Special firmware in the network computer that allows it to boot without being connected to a host computer.

**RGB**
An additive method of combining percentages of red, green, and blue primary colors to form other colors.

**ROM**
See Read-Only Memory.

**Root Weave**
The window that fills the screen during an X session. All windows opened by clients appear on top of the root window. See Stipple Pattern.

**RS-232-C**
A standard communications interface defined by the Electronic Industries Association (EIA) to control data communications using standard voltages, signal lines, and device interactions.

**Screen**
The monitor. This is where text and graphical information is displayed for viewing. See Window.

**Select (mouse button)**
The factory default defines this as the left mouse button.

**Setup Key**
A special key on the keyboard, marked Setup. Pressing this key takes you to the Setup program.
Glossary

Serial Port
One or more optional physical connectors on your network computer. Attach a serial cable (RS 232) to communicate with a peripheral device such as a modem or printer.

Serial Port Session
A session started through one of the serial ports: either Serial Port 0 or Serial Port 1.

Serial Xpress (SXp)
A serial protocol used for fast serial communications between a host computer and a network computer. Can be used with or without a modem.

Server
The combination of graphics display, hardware, and server software that provides display services for clients. The server also handles keyboard and mouse input. See Client and X Server.

Setup
A local X client program used to configure the network computer.

Software
A set of instructions that tell the computer to perform a certain task in order to obtain a specific result. See Client.

Stipple Pattern
In the X Window System, the underlying pattern displayed (with the X cursor) when there are no other windows on the screen. If a window is created, the window appears on top of the stipple pattern. See Root Window.

SXp
See Serial Xpress.

TCP

TCP/IP
Glossary

Telnet
A user-level protocol which is part of the Internet Protocol set. Telnet provides a Network Virtual Terminal, which allows you to log in to a remote host on the network as if you are using a terminal directly attached to the remote host.

TekHostMenu
See HostMenu.

Terminal
An interactive input/output device used in computer systems or networks.

Text Cursor
The I-shaped pointer which appears in a text input area. Clicking the mouse in a text input area causes the text cursor to appear in that area. Whatever information you type on the keyboard appears in the text input area displaying the text cursor.

TFTP
See Trivial File Transfer Protocol.

Transmission Control Protocol (TCP)
The Internet transport layer protocol which provides a reliable, bi-directional byte stream connection between two cooperating user-level processes.

Transmission Control Protocol/Internet Protocol (TCP/IP)
Using the TCP and IP protocols to obtain a reliable, bi-directional byte stream connection between two cooperating user-level processes. Commonly this refers to the entire Internet Protocol suite, including TCP, IP, UDP, ICMP, and other protocols.

Trivial File Transfer Protocol (TFTP)
A protocol used for downloading server images. It is also used for reading and writing font files, the color definition file, or remote configuration files.

UNIX
A host operating system.
Glossary

Value
A term describing the lightness or darkness of a color. Value ranges from 0 (black) to 100 (white). See Chroma and Hue.

WinDD
A client that allows you to access and run Windows NT applications from your network computer.

Window
In the X Window System, typically a region on the screen of a display created by an X client for displaying data. (An X client can create more than one window.) For example, the xterm terminal emulator, xfd font displayer, and the bitmap graphics editor all create windows. You can use a window manager to manipulate windows on the screen. See Window Manager.

Window Manager
An X client that allows you to organize and rearrange windows. The window manager controls the size and placement of windows and can also control window attributes such as border size.

Xhost
A host X program that controls access to the server from the host program.

X Server
A program that runs locally on a network computer and lets you use the screen of the network computer. The X server processes a request (for example, a request to create a window), collects input data, and sends information (called an event) to clients. See Event.

Xterm
An X client that emulates an ANSI-style terminal for programs that do not use the capabilities of windows directly.

X Window System
A set of network protocols developed by MIT for workstations; also called X or X11.
Index

A
Acrobat Reader
converting PDF to PostScript 4-72
Adjusting
keyboard vii
monitor vii
Analog Video Player 4-40
Audio file information 4-20
Audio Mixer 4-21
saving level settings 4-23
starting 4-22
Audio Player 4-2
Audio Accessories 4-16
audio file information 4-20
DAP access 4-12
External Devices 4-15
file types 4-2
NFS access 4-9
opening and creating a file 4-6
playing an audio file 4-19
recording an audio file 4-17
starting 4-4
tftp access 4-7

B
Boot process 2-2

C
Client Launcher 2-5
color hardcopy printing 4-75
Communication port vii
compose key on VT200 keyboard A-26
Console window 5-4
Cterm 2-13

D
deiconifying a window 3-11
diacritical keys on VT200 keyboard A-23
Digital Video Player 4-24
DAP access 4-32
Multicast 4-36
NFS access 4-31
opening a video file 4-28
playing a video file 4-34
starting 4-25
tftp access 4-29
DP mode keys A-1

F
Font caching 4-74

G
graphs 3-2

H
hardcopy 4-75
HostMenu 2-6

I
icon, moving 3-12
iconifying a window 3-11

K
Keyboard vii
keyboards
compose key A-26
compose sequences A-26
diacritical keys A-23
North American special characters
Index

A-9
special characters and symbols A-21

L
LAT 2-22
listnx 4-73
locking a window 3-14
Logging in
  Cterm 2-13, 2-15
  HostMenu 2-6
  LAT 2-22
  login prompt 2-9
  methods 2-3
  root weave 2-4
  Serial Port 2-19
  Telnet 2-11
  WinDD 2-15
Logic board vii
Logic module vii
Login prompt 2-9
lowering a window 3-10

M
Manual
  conventions v
  mouse terminology v
  related documentation viii
maximizing a window 3-10
Memory 4-74
Monitor vii
Mouse vii
Mouse buttons v
moving
  icons 3-12
  windows 3-8
MPEG video file format 4-34
Multicast 4-36
  Channels 4-36

N
Network computer
  boot process 2-2
  memory 4-74
  package vii
  software vii

P
pictures 3-2
Power switch locations 2-1
printing
  color hardcopies 4-75
  from the command line 4-76
  from the MWM pop-up menu item 4-75
  hardcopy of a window 4-75
  hardcopy of the screen 4-75
PSXpress 4-67
  documentation location 4-73
  execution path 4-67
  launching Acrobat Reader 4-70
  launching applications 4-69
  PATH variable 4-67
  PostScript resources 4-68
  preferences file 4-70
  printing with Acrobat Reader 4-72
  using Answerbook 4-68
  using with other applications 4-73
  X resources 4-68
Index

R
raising a window 3-9
Rebooting the Network Computer 3-4
Resetting
  Network Computer 3-4
  X server 3-4
resizing a window 3-8
Root weave 2-4

S
Serial
  communications 2-20
  parameters 2-20
  port session 2-19
  Serial Xpress (SXp) 2-21
Serial Xpress 2-21
server 3-2
Setup key v, 2-4, 2-20, 3-4, 3-6, 3-13
SXp 2-21

T
Telnet 2-11
text 3-2

V
VT200 keyboards
  compose key A-26
  compose sequences A-26
  diacritical keys A-23
  special characters and symbols A-21

W
WinDD
  about 4-59
  configuring 4-63
  help menu 4-66
  local client 4-59
  local client Options menu 4-65
  log in 2-15
  log in screen 2-17
  logoff 2-18
  selecting a server 2-16, 4-64
  starting with xp.cnf 4-59
  starting with xpsh 4-60
window
  deiconifying 3-11
  iconifying 3-11
  lowering 3-10
  maximizing 3-10
  moving 3-8
  raising 3-9
  resizing 3-8
Window managers 3-5
Windows 3-7

X
X server
  see server 3-2
XIE Viewer 4-48
  DAP access 4-55
  NFS access 4-53
  opening an image file 4-51
  starting 4-49
  tftp access 4-52
  viewing options 4-58